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Welcome
Congratulations on your purchase of a Nexus 870 spectrometer
from Nicolet! The spectrometer lets you collect spectra in the
mid-IR, far-IR and near-IR spectral ranges. The 870 has all of the
features of the other Nexus spectrometers, plus step-scan, dual
channel collection and other advanced features. The system
integrates advanced hardware features with the power and flexibility
of Nicolet’s OMNIC® software*.

This manual explains how to use the system to collect and process
FT-IR spectra after it is installed by Nicolet. Included is information
on using your OMNIC software as well as chapters on how to
operate, maintain and service the spectrometer.

*

Some dedicated systems use other Nicolet software packages.
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Warning

The Spectrometer Safety Guide that came with your system contains
important safety information. This guide is available in several
languages. Contact your local Nicolet office for information about the
languages that are available. Before using the system, read the entire
guide. To prevent personal injury and damage to equipment, follow the
precautions contained in the guide whenever you use the system. ▲
The Nexus 870 has these advanced capabilities:

• Step-scan data collection using either amplitude or phase
modulation.

• Slow-scan linear data collection.
• Dual-channel linear scan PEM (photoelastic modulation) data
collection.

• Optional TRS (time-resolved step-scan) data collection.
• SMM (synchronous multiple modulation) data collection.
This manual explains how to use the system to collect and process
FT-IR spectra after it is installed by Nicolet. Included is information
on using your OMNIC software as well as chapters on how to
operate, maintain and service the spectrometer.
If you have not used the spectrometer before, view the
“Spectrometer Tour” and “Getting Started With OMNIC” tutorials
available through Getting Started in the Help menu of OMNIC.
You can also read the “Before You Collect Spectra” and “Your First
Experiment” chapters to learn how to start the system and collect and
work with spectra.
See “Where to find the information you need” later in this chapter
for a description of the on-line documentation provided with the
system and for help finding the answers to your questions.
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You can replace key parts of the spectrometer, such as the laser and
light source. Installation instructions are available on-line. See
“Where to find the information you need” for details.
Instructions for most accessories are included with the particular
accessory. Additional information on connecting accessories is
included in this manual.
You can contact Nicolet at the numbers below. Outside the U.S.A.
call your local sales or service representative. Telephone numbers for
all Nicolet Customer Support offices are provided with your system.

•
•
•
•

Telephone (U.S.A.):
Fax:
World Wide Web:
E-mail:

1-800-NICOLET (1-800-642-6538)
1-608-273-5045
http://www.nicolet.com
nicinfo@nicolet.com
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Conventions

The following conventions are used in this manual to draw your
attention to the on-line documentation and other important
information.
This symbol tells you that you can find more information in the online tutorials. To access a tutorial, click the Help menu in OMNIC.

?

This symbol tells you that you can find more information in the online OMNIC Help or SST Help systems. Choose OMNIC Help
Topics from the Help menu, or choose SST Help Topics from the
SST menu.
This symbol tells you that you can find more information in this
manual.

Note

▲ Caution

Warning

Danger
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Messages like this contain helpful supplementary information about
a procedure or technique. ▲

Follow the instructions given in Cautions to avoid damaging the
spectrometer or losing data. ▲

Always heed the Warnings that appear in this manual to avoid being
injured while using the spectrometer. ▲

Follow the instructions labeled Danger to avoid serious injury or loss
of life while using the spectrometer. ▲

System requirements

For optimum performance we recommend that your system have, at
a minimum, the following items:

•
•
•
•
•
•
•
•
•
•
•
•
•

Intel® Pentium® processor with 166 MHz or greater clock speed.
At least 64 megabytes of random access memory (RAM).
The ability to display 16-bit color images.
Hard disk size of at least 1.0 gigabyte.
Quad speed CD-ROM drive.
A 1.44-megabyte floppy disk drive for 3.5-inch floppy disks.
A 15-inch SVGA monitor with 800 by 600 resolution.
A keyboard and serial or bus mouse or PS/2®-style mouse.
16-bit Sound Blaster compatibility.
Two serial ports.
Two open PCI slots.
One open ISA slot.
Windows® 98 or Windows NT 4.0 or greater.

Nexus 870 User’s Guide
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Where to find the
information you need

The on-line and printed documentation included with your system is
designed to let you find the information you need quickly. We
recommend first using the on-line documentation provided with
OMNIC when you have a question. OMNIC includes several on-line
tutorials, a wizard and a complete Help system. See “Starting
OMNIC” in the next chapter for information on starting OMNIC.
The tutorials teach you how to do these things:

• Use OMNIC features to collect, display and process spectra.
• Set up your spectrometer for a variety of experiments. You can
learn how to change sources, beamsplitters and detectors; install
optical filters and screens; and change the sample compartment
baseplate.

• Install optional hardware.
• Check and change the desiccant, and purge line filters.
• Change replaceable parts.
• Get part number and ordering information.
Note

You must have the Spectrometer Tutorials CD in the computer’s
CD-ROM drive to use the “Spectrometer Tour” tutorial or view any
videotaped parts replacement procedures in the “Spectrometer Help
Topics” tutorial. ▲
You can also find part numbers and hardware setup and replacement
procedures with the computer not connected to the spectrometer.
Insert the Spectrometer Tutorials CD into the computer’s CD-ROM
drive and double-click the icon for the P870_ENU.HLP program.
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To use a tutorial, choose it from the Help menu or point to Getting
Started, Learning OMNIC or Sampling Techniques in the menu and
then choose the desired tutorial from the list that appears. You can
also start tutorials from within other parts of the on-line
documentation provided with OMNIC.
SST Help Topics in the SST menu provides complete information
about setting up hardware and software for SST experiments.
The Library Creation Wizard prompts you, step by step, through
creating a user library of spectra.
The on-line OMNIC Help system lets you quickly find answers to
your questions about using the software. There are several ways to
enter OMNIC Help:

• You can see information about a particular feature in OMNIC
(such as a parameter in a dialog box) by clicking the item using
the right mouse button. A brief description of the item appears,
and in most cases one or more buttons that you can click to
display more detailed information. Here is an example:

Click the Discussion button to display a complete discussion of the
item (or the dialog box or window that contains the feature). Click
the How To button to display a step-by-step procedure for using
the item (or the dialog box or window that contains the item).

• You can press the F1 function key to see a discussion topic for
the currently displayed or selected feature, dialog box or window.

Nexus 870 User’s Guide

7

• If a dialog box or window contains a Help button, click it to see
information about the dialog box or window (or the command
that displayed it).

• To see the Contents of the OMNIC Help system, choose OMNIC
Help Topics from the Help menu.
Here is an example of the Contents tab showing the contents of
some of the books in the system:
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Before You Collect Spectra
It’s easy to collect spectra with your spectrometer. By leaving the
system turned on at all times—with the needed components already
installed—you can keep it ready to use with a minimum of
preparation. Keeping the system on also improves its stability and
gives you more consistent results.
All the things you need to check before collecting spectra are listed
below; each of these items is discussed in a section of this chapter.
By the time you have run through these items once or twice in the
course of your work, you will know how to check the system and
start collecting spectra quickly.

• Check the purge or desiccant.
• Make sure the system components are on.
• Cool the detector (if you are using an MCT, InSb or other
detector that requires cooling with liquid nitrogen).

• Start OMNIC and select an experiment.

Nexus 870 User’s Guide
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Checking the purge
Skip this section if you purchased
the “Sealed and Desiccated” option.

If your spectrometer is purged but you don’t have the Smart Purge
option, make sure the pressure regulator is set between 20 and 40
pounds per square inch (psi) and the flowmeter reads approximately
30 standard cubic feet per hour (scfh). The settings for Smart Purge
are given in the next section; read this section first.
If you need to adjust the flow rate, or if your application requires a
different flow rate, follow the instructions in “Setting the purge gas
controls” in the “Setting up experiments” book in Spectrometer Help
Topics.

Warning

Never use a flammable gas to purge the spectrometer. The purge gas
must be free of moisture, oil, carbon dioxide and other reactive or
infrared-absorbing materials. Use dried air or nitrogen to purge the
spectrometer. Other gases, even inert gases such as argon, can damage
the spectrometer and should never be used for this purpose. ▲
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We recommend that you leave the purge on at all times. This keeps
the spectrometer free of undesirable gases, protects the optics and
improves the system’s thermal stability.
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In Spectrometer Help Topics view “Maintaining your spectrometer”
for information on how to install the purge equipment, set the
controls for the first time, and inspect and clean the purge filter. In
the Spectrometer Tour (available through Getting Started) view
“Sample compartment” for information on using Smart Purge.

Smart Purge settings

The Smart Purge option increases the purge gas flow rate when you
install or remove samples. If you have this option, set the pressure
regulator to 80 psi. The auxiliary tank may be required depending on
the flow rate supplied by your purge gas source. See the following
table for details.

Flow Rate*

Tank Required?

Comments

less than
50 scfh

yes

Some purge gas and pure air
generators provide a flow rate of
less than 50 scfh.

50-99 scfh

optional

Using the tank will improve
performance.

100 scfh or
greater

no

A flow rate of 100 scfh gives the
best results.

* Flow rates greater than 50 scfh cannot be measured with the flowmeter installed by
Nicolet. See your air dryer manual or contact the department that maintains your purge
equipment if you don’t know the flow rate of the purge gas source.

?

You can use OMNIC to set the duration of increased purge flow. In
OMNIC Help Topics find “purge” in the Index and go to “Setting
Smart Purge.”
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Checking
the desiccant

If your spectrometer is sealed and desiccated, a bag of desiccant is
located under the beamsplitter compartment cover. The desiccant
protects the beamsplitter and other optical components by reducing
the amount of water vapor inside spectrometer. See “Checking and
changing desiccant” in the “Maintaining your spectrometer” book in
Spectrometer Help Topics if you need to change the desiccant.
If your spectrometer is in use, check the humidity level inside it
monthly (more often in very humid climates) by clicking the Check
Desiccant button on the Diagnostic tab of the Experiment Setup
dialog box. If the level exceeds the factory-specified limit, a message
informs you. Be sure to change the desiccant so that the optics will
be protected.
If your spectrometer is in storage, check the round, blue indicator on
the desiccant holder under the beamsplitter compartment cover
monthly. Change the desiccant if the indicator has turned pink. Keep
all covers closed tightly while the spectrometer is in storage.

Note

?
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The Check Desiccant button measures humidity more accurately
than the indicator. For this reason you should rely on the button to
monitor the performance of the desiccant when the spectrometer is in
use. Rely on the indicator only when the spectrometer is in storage. ▲
See “Ordering parts” in Spectrometer Help Topics to find the part
number for ordering desiccant bags.

Turning on the
system components

We recommend that you keep your spectrometer on at all times,
unless the building is subject to power outages or you need to
perform a service or maintenance procedure. Leaving the system on
keeps it stable and gives you the most consistent results. If you must
turn the spectrometer off, allow it to stabilize for at least 15 minutes
(one hour for best results) before collecting spectra.
Follow these steps to turn on the system components:
1. If the external power supply is not already connected,
connect it.
In the Spectrometer Tour (available through Getting Started)
view “Connecting to AC power” in the “Powering up” unit for
information on connecting the power supply.
2. Turn on any accessories you plan to use.
This includes accessories such as a gas chromatograph, a GC
interface or an infrared microscope.
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Warning

Always follow the safety precautions described in this manual and in
the Spectrometer Safety Guide that came with your system. ▲
3. Turn on the spectrometer by pressing the power switch (I/O)
on the external power supply to I.

Power switch

When you turn on the spectrometer, the four status indicators—
Power, Scan, Laser and Source—flash in various sequences as
the system runs through its diagnostic routines. When the
routines are finished, the Power, Laser and Source indicators stay
lighted. The Scan indicator flashes with each scan of the
interferometer.
After you turn on the spectrometer, let it stabilize for at least
15 minutes (one hour for best results) before collecting spectra.
See “Turning on the spectrometer power” in the “Spectrometer
Basics” chapter if you need more information.

4. Turn on the printer and then the computer.
Turn on the printer and computer as explained in the
documentation that came with those components.
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Reverse the order given in the preceding procedure when you turn
off system components:
1.
2.
3.
4.

Cooling the detector

Warning

Turn off the computer.
Turn off the printer.
Turn off the spectrometer.
Turn off the accessories.

Some detectors, such as an MCT or InSb detector, require cooling
with liquid nitrogen. In Spectrometer Help Topics view “Cooling a
detector” in “Setting up experiments” for instructions.

Liquid nitrogen is extremely cold and therefore potentially
hazardous. Avoid contact with skin. Wear protective clothing and
follow standard laboratory safety practices to prevent injury. ▲
After you fill the detector dewar with liquid nitrogen (the dewar
holds about 750 mL), allow the detector to cool at least 20 minutes
before collecting spectra.

Nexus 870 User’s Guide
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Starting OMNIC

Follow these steps to start OMNIC:
1. Start the Windows software.

2. Double-click the OMNIC E.S.P. shortcut.

The shortcut is on
the Windows desktop.

Depending on how the program has been configured, dialog
boxes may appear asking for a user name and password. Type
your user name if requested, and then choose OK. Enter a
password if required.
The OMNIC window appears. This window is described in the
next chapter.
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Selecting
an experiment

By selecting an experiment from the Experiment drop-down list box
below the OMNIC menu bar, you can quickly set the software
parameters for the type of data collection you want to perform.

A number of experiments are provided with OMNIC, and you can
create and save your own. If you install a Smart Accessory, the
correct experiment is selected automatically (or a list of appropriate
experiments is made available for your selection).
In the tutorial in the next chapter the provided Default - Transmission
(or Transmission E.S.P.) experiment is used. You will probably find
that this experiment is suitable for most of your applications.
If you want to check or change the parameters after selecting an
experiment, use Experiment Setup in the Collect menu.
You are now ready to collect spectra.
To learn more about experiments, see “Opening an experiment” in
the “Preparing the software” unit of Collecting a Spectrum (available
through Learning OMNIC). If you need to install or change a source,
beamsplitter or detector for your experiment, follow the instructions
in “Setting up experiments” in Spectrometer Help Topics.
Note

The most commonly used hardware configuration for mid-IR
experiments includes a KBr beamsplitter, an Ever-Glo (mid-IR to
far-IR) source and a DTGS detector. You may need to change the
settings of the example experiment if your hardware configuration is
different. ▲
If you have not used the system before, you can learn how to
perform an experiment by viewing Collecting a Spectrum (available
through Learning OMNIC) or by using the tutorial in the next
chapter of this manual.

Nexus 870 User’s Guide
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Your First Experiment
This chapter will get you started collecting spectra with your
spectrometer and working with the data using OMNIC. You will
learn how to do the following things:

•
•
•
•
•
•
•
•
•
•

Open a configuration.
Select an experiment and check the parameters.
Install a sample and collect a sample spectrum.
Save the spectrum.
Convert the spectrum to other units.
Label a peak in the spectrum.
Verify the composition of the sample by comparing the spectrum
with spectra in a QC library.
Create and print a report containing the spectrum.
Add the spectrum to a user library.
Create a user library.

You can learn all these things and more by running the on-line
tutorials provided with OMNIC. Start with the Spectrometer Tour
and Getting Started With OMNIC (available through Getting
Started).
Follow the instructions in the preceding chapter to prepare the
system and start OMNIC before using this chapter.
Note

If you have a dedicated system (such as an ECO/RS) that normally
uses a software package other than OMNIC, skip this chapter. See
the special documentation that came with your system for
instructions on using that software. If you need information on using
the spectrometer, see the chapters that follow this one. ▲
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The OMNIC window

The large window that appears on the screen when you start OMNIC
is called the OMNIC window.
Experiment drop-down
list box

Menu bar

Toolbar

Bench Status
indicator

Spectral window

Spectral window

Menu bar
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Within the OMNIC window is a spectral window, which you can use
to display and manipulate spectra. When a spectrum is displayed in a
spectral window, you can use OMNIC commands to perform
operations on it. For example, you can change the spectrum’s format
or search it against a spectral library to identify it.

Below the title bar is the menu bar, which contains all of the OMNIC
menu names. The menus are arranged in an order that you’ll find
convenient as you use the software. All of the menu commands are
explained in detail in the on-line tutorials or the OMNIC Help system.

Experiment
drop-down list box

Bench Status indicator

Below the menu bar is the Experiment drop-down list box. The
Experiment drop-down list contains all of the experiment files you
have opened, plus the default experiment file and an experiment file
for any Smart Accessory you have installed. By selecting an
experiment with this feature, you can quickly set the software
parameters for the type of experiment you want to perform. You can
see the parameter settings for the selected experiment by using
Experiment Setup in the Collect menu.

To the right of the Experiment drop-down list box is the Bench
Status indicator.
If the indicator is a green check mark, the spectrometer has passed
all of its diagnostic tests.
If the indicator is a yellow circle, a cooled detector in the
spectrometer has become warm. A message appears explaining the
problem and allowing you to access information on correcting it.
If the indicator is a red X, the spectrometer has failed a diagnostic
test and requires corrective action. A message appears explaining the
problem and allowing you to access information on correcting it.

Note

Toolbar

?

If you want to view the on-line videos to help troubleshoot a
problem, put the Spectrometers Tutorials CD into the computer’s
CD-ROM drive. ▲

Below the Experiment drop-down list box is the toolbar. Each button
in the toolbar represents a menu command, a macro or an external
program. To see the name of the command or feature for a button,
point to the button and wait a moment. To initiate the command or
feature, click the button with the left mouse button.
In OMNIC Help Topics find “toolbar” in the Index and go to
“Displaying and using a toolbar” for information on using and
customizing the toolbar buttons.
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Collecting a
sample spectrum

A sample spectrum is usually ratioed against a background spectrum.
The background spectrum measures the response of the spectrometer
without a sample in place. Dividing the sample spectrum by the
background—called “ratioing”—removes the effects caused by the
instrument and atmospheric conditions so that the peaks in the final
spectrum are due solely to the sample.
Here is a typical background spectrum:

For most applications you don’t need to collect a new background
spectrum for each sample spectrum if you haven’t changed the
software parameters. To obtain good results, however, collect a new
background regularly, perhaps once every four hours. (You can
obtain the best results by collecting a new background for each
sample, but this is seldom necessary.)
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Installing the
standard sample holder

If the standard sample holder is not already installed, install it now.
The following illustration shows the sample holder in place.

Accessory
support

Sample
holder
Height
adjustment
screw

If you are using separate Snap-In™ sample compartment baseplates
for different accessories and sample holders, you can quickly switch
baseplates to install the sample holder. For information on using
Snap-In baseplates, view “Removing the Snap-In baseplate” in
“Setting up experiments” in Spectrometer Help Topics.
If your sample holder is mounted on a Smart baseplate, the
Transmission E.S.P. experiment is automatically selected when you
install the baseplate in the sample compartment.
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If your sample holder is not installed on a baseplate, use a flat-blade
screwdriver and the slotted screws to attach the holder to a baseplate
as shown below. Then install the baseplate in the sample
compartment.

If there is a sample in the
holder, remove the sample.

To install a sample or filter, slide the sample or filter into one pair of
slots. If the accessory support is currently installed in the slot you
want to use, remove the support before installing the sample or filter
(see the first illustration in this section). Replace the support when
you are finished using the slot. Do not discard the support; it is
needed for installing slide-mounted accessories.

Collecting the
sample spectrum

In the data collection procedure that follows, you will collect a
background spectrum and then a spectrum of the provided
polystyrene sample. Before collecting the spectra, you will open a
configuration that sets a number of software options for this
procedure.
You can also learn how to collect spectra by viewing Collecting a
Spectrum (available through Learning OMNIC).
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Follow these steps:
1. Choose Open Configuration from the File menu.
The Open Configuration dialog box appears listing the available
configuration files. Opening one of these files lets you quickly
set a number of software options.

2. Select the DEFAULT.CON file and then choose OK.
This file was provided with your OMNIC software for setting the
options for this procedure.

3. Select the Default - Transmission experiment (or the
Transmission E.S.P. experiment).
Both of these experiments set the parameters correctly for
collecting a polystyrene sample spectrum. If either of them is
already selected, you do not need to select an experiment. The
currently selected experiment is shown in the Experiment box
near the top of the OMNIC window.
To select the Default - Transmission (or Transmission E.S.P.)
experiment, first click the arrow button at the right end of the
Experiment drop-down list box. The Default - Transmission (or
Transmission E.S.P.) experiment appears in the list.

Select the Default Transmission (or Transmission
E.S.P.) experiment by clicking it.
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A number of other experiments are provided with OMNIC for
performing a wide variety of data collections. You can select
these experiments by using the Open button in the Experiment
Setup dialog box. After you have selected one of them the first
time, the experiment will appear in the Experiment drop-down
list for future selection. You can also set up and save your own
experiments.

4. Check the settings of the parameters by choosing Experiment
Setup from the Collect menu.
This step is normally not necessary, but it’s a good way to
become familiar with the parameters. The Experiment Setup
dialog box appears.
If data collection parameters shown below are not already
displayed, click the Collect tab to display them.
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The data collection parameters, along with the other experiment
parameters, determine how OMNIC collects background and
sample spectra. In OMNIC Help Topics find “experiment” in the
Index and go to “Using Experiment Setup” for more information.
Notice that the Collect Background Before Every Sample option
is selected. This option prompts you to collect a background
spectrum before you collect a sample spectrum.
The File Handling box contains options for saving data
automatically. When Save Automatically is on, OMNIC saves
collected spectra immediately after collection, naming the files
using the base name specified in the Base Name box plus a
sequence number with up to four digits, followed by an extension
such as .SPA for spectra. The files are saved using the path
shown below the base name.
If Save Interferograms is on, the interferograms for your spectra
are saved when you save the spectra. Interferograms are the raw
spectral data. Saving them allows you to reprocess a spectrum
later in case you want to restore it after performing corrections or
other operations on it.

?

Leave the options in the File Handling box as they are for this
procedure. In OMNIC Help Topics find “file” in the Index and
go to “File handling” if you want more information on the File
Handling options.
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Click the Bench tab to display the spectrometer parameters.

Verify that the Beamsplitter, Detector and Source settings match
the components you have installed in your system.
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Click the Quality tab to display the spectral quality checks.

The selected checks on this tab are performed automatically
during data collection. (In the Default - Transmission experiment
the checks are turned off.) If a problem is found by a check, the
software informs you and provides information to help you
correct the problem. This is explained in more detail later in this
procedure.

5. Choose OK to close the Experiment Setup dialog box.
You are now ready to collect a spectrum of the provided
polystyrene sample.
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6. Click the Collect Sample button in the toolbar.

You can also choose Collect
Sample from the Collect menu.

The Collect Sample window appears and then a dialog box
showing the default title for the sample spectrum:

7. Type a title in the text box or choose OK to accept the default.
Since the experiment you are using specifies that a background
should be collected before every sample, a message appears now
asking you to prepare to collect a background spectrum.

This means that you need to remove any sample from the sample
holder so that the beam path is clear. When you then collect a
background spectrum, the result is a measurement of the
response of the spectrometer alone; that is, without absorptions
due to a sample.
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8. Look through the sliding door to make sure there is no
sample in the sample holder and then choose OK to start
data collection.
If there is a sample in the sample holder, remove it before
choosing OK:
If your spectrometer is purged but does not have the Smart Purge
option...
Open the sliding door, remove the sample, close the sliding
door and then wait 1 minute before choosing OK.
If your spectrometer has the Smart Purge option...
Open the sliding door, remove the sample and then slide the
door until it is open about 1 cm. When you hear the purge
flow rate return to normal, close the door all the way and
choose OK.
If your spectrometer is sealed and desiccated...
Open the sliding door, remove the sample, close the sliding
door and then choose OK.
A background spectrum appears in the Collect Sample window.
The spectrum is updated as more data are collected. When all the
background data have been collected, a message appears asking
you to prepare to collect the sample spectrum:
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9. Install the polystyrene sample through the sliding door, wait
if necessary (see the instructions below) and then choose OK.

If your spectrometer is purged but does not have the Smart Purge
option...
Open the sliding door, install the sample, close the sliding
door and then wait 1 minute before choosing OK.
If your spectrometer has the Smart Purge option...
Open the sliding door, install the sample and then slide the
door until it is open about 1 cm. When you hear the purge
flow rate return to normal, close the door all the way and
choose OK.
If your spectrometer is sealed and desiccated...
Open the sliding door, install the sample, close the sliding
door and then choose OK.
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For more information on installing samples, view “Installing
Samples” in the Spectrometer Tour (available through Getting
Started).
As data are collected, the sample spectrum in the Collect Sample
window is updated. Here is the Collect Sample window during
sample data collection:

The progress of the collection is indicated visually by the gauge
above the tool palette. The number of scans collected so far and
the total number of scans for the collection are displayed to the
right of the gauge.
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The Collect Status indicator above the view finder shows the
status of the collection during and after collection. When the
indicator is a green check mark, it shows that the spectrum has
passed all of the selected spectral quality checks made so far.
After the collection is finished and the indicator is a green check
mark, you can add the spectrum to a spectral window (if it is not
added automatically).
If you ever have a problem with data collection while one or
more quality checks are turned on, the Collect Status indicator
may change. If the indicator is a yellow circle, the spectrum has
failed a spectral quality check (a measured value was not within
the allowed range), but it is not serious enough to stop the
collection. If the indicator is a red X, there is a problem with the
quality of the spectrum. After correcting the problem, collect the
spectrum again.
To view information about the collection, including any problems
that have occurred, click the indicator during or after the collection,
or click the View Collect Status button as explained below.
When all the sample data have been collected, the following
message appears asking whether to add the spectrum to a spectral
window:

Choosing View Collect Status
displays the Results window,
which shows a summary of
problems encountered and other
information about the collection.

Clicking the View Collect Status button displays the Results
window, showing a summary of any problems encountered
during data collection and other information about the collection.
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10. Choose Yes to add the sample spectrum to the spectral
window.
Choosing No ends the procedure without saving the spectrum.
Choosing Cancel returns you to the Collect Sample window,
allowing you to collect more scans with the More button.
Here is the sample spectrum displayed in the spectral window:
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Saving the spectrum

You can save your spectrum manually on the hard disk by using
either of two commands in the File menu: Save or Save As. Use
Save when you want to save a spectrum on the disk using the current
filename and path. In this example you will use Save As to save a
spectrum in a file on the disk using a new filename.
Follow these steps to save the polystyrene spectrum you just
collected:
1. Select the polystyrene spectrum by clicking it.

2. Choose Save As from the File menu.
The Save As dialog box appears.

3. Type the name POLY.SPA following the directory path in
the File Name box.
The text can be either upper or lower case. The default directory
path for saving files is determined by the settings on the File tab
of the Options dialog box, available through Options in the Edit
menu.

4. Choose OK.
If you typed a filename that already exists in the directory, a
message appears asking whether to replace the existing file.
Choose No and then use a different filename to save the
spectrum.
In the next section, you will convert the spectrum to
% transmittance and back to absorbance.
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Converting the
spectrums units

The sample spectrum you collected is in absorbance units. Since many
of OMNIC’s data manipulation commands work best on spectra in
absorbance units, it is often useful to convert a spectrum to absorbance
by using the Absorbance command. In this example you will convert
the spectrum to % transmittance and then back to absorbance.
1. Select the spectrum by clicking it.

2. Click the % Transmittance button in the toolbar.
You can also
choose % Transmittance
from the Process menu.

The spectrum is converted to % transmittance units:

Spectrum in % transmittance units
Nexus 870 User’s Guide
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The Process menu allows you to convert spectra to several other
units as well. These units are discussed in detail in the OMNIC
on-line Help system. In OMNIC Help Topics find “converting
spectrum” in the Index and go to the topic that deals with the
units you are interested in.

3. Click the Absorbance button in the toolbar to return the
spectrum to absorbance units.

You can also choose
Absorbance from the Process menu.

In the next section, you will label a peak in the absorbance
spectrum using the annotation tool.
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Labeling a peak with
the annotation tool

The palette contains six tools that let you select a spectrum or
spectral region, change how spectra are displayed in a spectral
window, find the height or area of a peak, or label a peak. The names
and appearance of the palette tools indicate their functions.

Region

Selection

Peak height

Spectral cursor

Annotation

Peak area

Follow these steps to label a peak in the polystyrene spectrum:
1. Select the annotation tool by clicking it.

The annotation tool lets you label peaks with their frequency
locations (X values) or other information.
Only one tool can be used at a time. To use a tool, first select it by
clicking it. A tool remains selected until you select another tool.
When you use a tool, the readout above the palette may display
information for the tool operation; for example, the X and Y
values of the pointer location or the limits of the selected spectral
region. Here is an example of X and Y values displayed in the
readout when the selection tool is selected and the pointer is
within a pane of a spectral window:
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When the annotation tool is selected and you move the pointer
into a pane of a spectral window, the pointer looks like this:

You can label a peak by clicking above it with the annotation
tool. This displays the label text above the peak with a line
connecting the label to the peak. The text is selected so that you
can immediately edit it. When you press Enter, the label appears
in its final form.
You can more accurately locate the top of a peak by holding
down the Shift key when you click near the peak.

2. Label the peak near 2,924 wavenumbers by holding down the
Shift key and clicking a little above the peak.
The label appears:
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3. Press Enter to accept the label text.
You could also perform other operations on the label using the
annotation tool. To modify a newly created label, edit the
selected text before pressing Enter. To modify an existing label,
click it and then type a new label and press Enter. To delete an
existing label, click it and then press the Delete key.
?

In OMNIC Help Topics find “tool, annotation” in the Index and
go to “Annotation tool” for more information on the annotation
tool.
In the next section, you will compare the spectrum with the
spectra in a QC library to verify the composition of the sample.
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Verifying the
composition
of the sample
Note

You can verify the composition of your polystyrene sample by
automatically comparing the collected spectrum with the spectra in a
QC (Quality Control) library. The software compares the sample
spectrum with reference spectra in the appropriate category in the
library and then tells you whether the sample matches a library
spectrum.
If you were unsure of the composition of the sample, you could
perform a “spectral search” using a search library. In that case, the
software would search the library and then display a list of the
library spectra that best matched the unknown spectrum. ▲
Follow these steps to perform a QC comparison:
1. Select the spectrum by clicking it.

2. Choose Library Setup from the Analyze menu.
The Library Setup dialog box appears with the Search Libraries
tab displayed.
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The Library Directories box lists the directories that are currently
being used for spectral searches and QC comparisons. All the
libraries in the listed directories are available for your QC
comparison.

3. Add the LIBS directory (within the OMNIC directory) to the
list of directories if it is not already in the list.
This is the directory that contains the provided Polystyrene
Quality Control Sample library. To add the directory to the list,
choose Add Directory. In the dialog box that appears, locate and
select the LIBS directory, and then choose OK.

4. Click the QC Libraries tab to display the available QC
libraries.
The available QC libraries appear in the Available QC Libraries
And Groups box.
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The libraries listed in the QC Libraries And Groups box are the
libraries with which your spectrum will be compared.

5. Add the Polystyrene Quality Control Sample library to the
comparison list.
To do this, click the Polystyrene Quality Control Sample library
in the Available QC Libraries And Groups box, and then click
the Add button.

6. Choose QC Compare in the Library Setup dialog box to start
the comparison.
You can also close the Library Setup dialog box and begin a QC
comparison at any time by choosing QC Compare from the
Analyze menu.
When you begin a comparison, the QC Compare window
appears. At the bottom of the window a gauge shows the
progress of the comparison.
When the comparison is finished, the sample spectrum and the
library spectrum that best matches it are displayed in panes in the
upper portion of the window. Comments about the comparison
appear in the lower portion of the window. In this example the
comparison found that the sample spectrum matches the
polystyrene spectrum in the library.

7. Close the QC Compare window by choosing Close.
?
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In OMNIC Help Topics find “QC comparison” in the Index and
go to “Performing a QC comparison” if you want more
information about comparing sample spectra with QC libraries.

Creating and
printing a report

OMNIC makes it easy to create and print a report containing the
results of your work. Follow the steps below.

You can also view Creating Reports (available through Learning
OMNIC) to learn how to create and print reports and add them to
report notebooks.
1. Choose Template from the Report menu.
A dialog box appears allowing you to locate and select a report
template for the report.

2. Go to the REPORT directory (within the OMNIC directory)
and select the report template file named QCCOMP.RPT.
This file contains a report template specially set up for this
procedure. The template has items for the spectral window,
spectrum time, title and comments, and search results.
When you select the report template file, a preview image of the
template appears at the right. This feature allows you to see what
different templates look like so that you can pick one with the
items you need. You can view the image as a graphical layout by
selecting the Layout option. This shows you how the printed report
will look on paper. You can also view the image with template
items labeled by selecting the Description option. This lets you
identify items that are too small to be seen clearly.

3. Choose Select to make the example template the current
template for printing reports.
When you print your report, OMNIC will automatically fill in the
items with the appropriate information and images. For example, if
an item in the template is linked to the active spectral window, the
contents of that window are included when you print the report.
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You can create your own report templates by using the Create
button, or you can modify one of the existing templates
whenever you want to design a new template. Save the template
with a new name after you make your changes. In OMNIC Help
Topics find “report template, selecting” in the Index and go to
“Selecting, editing or creating a report template” for more
information on using reports.

4. Choose Preview/Print Report from the Report menu.
A preview of the report appears showing the report items filled in
with information about your spectrum. Your report should look
similar to this:
You can click the Zoom button to
see an enlarged image of the report.

The preview lets you check the content of the report before
printing it.
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5. If you have a printer connected to the computer, choose Print
to print the report.
The Print dialog box appears allowing you to set some
parameters that affect printing.

6. Choose OK.
The report is printed on your system printer.

Adding the
spectrum to
a user library

You can save your spectrum in a user library even if you have saved
it in a spectral data file. This allows you to find the spectrum later by
searching for text contained in the information saved with the
spectrum. If you add your own reference spectra collected from pure
sample materials to a user library, you can also use the library to
identify unknown spectra.
Follow these steps to add the polystyrene spectrum to a user library:
1. Select the polystyrene spectrum.

2. Choose Add To Library from the Analyze menu.
The Select Library dialog box appears listing all the user libraries
available in the currently specified library directories of the hard
disk.

3. Select the User Example Library.
This library has been created for you to use in this example.
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4. Choose OK.
The Add To Library dialog box appears showing the name of the
library you selected and the index number that has been assigned
to the spectrum. The dialog box also contains fields into which
you can enter information about the spectrum. The first field
already contains the compound name. You can accept or change
the text in the fields.

5. When you have finished entering information about the
spectrum, choose OK.
You can also add a spectrum to a library by dragging the
spectrum or the spectrum’s file to the library’s book on the
Library Names tab of Library Manager.
?
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In OMNIC Help Topics find “user library, adding spectrum to”
in the Index and go to “Adding user library spectra to another
user library” for more information on options for adding spectra
to libraries.

Creating a
user library

Creating your own library lets you customize the information in the
library depending on your search needs. You can create a search
library for identifying unknown spectra, a QC library for verifying
the composition of a sample, or a scrapbook library for storing
spectra to be retrieved later.
When you create a user library, you determine the kinds of information
that will be saved with it. You also set a number of parameters,
including the resolution and spectral range of the library and which
checks and corrections are performed. The Library Creation Wizard
leads you through the steps that are appropriate for the type of library
you are creating.
Once a library is created, you can add spectra to it with the Add To
Library button (or with Add To Library in the Analyze menu) and
use it just as you would a commercial library to identify unknown
spectra or verify the composition of a sample. If you create a
scrapbook library, you can find spectra in it by searching for text.
In this example you will create a new search library. Follow these
steps:
1. Choose Library Manager from the Analyze menu.
Library Manager appears with the Library Names tab in front.
2. Choose Create Library.
The Library Creation Wizard appears.
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3. In the Library Creation Wizard, select Search Library, and
then enter a name and filename.
The name you enter for the library will appear in the Library
Names list when you add a spectrum to a library. You can enter a
new filename or accept the default name the Wizard assigns.
Click Next to continue.

4. In the next dialog box, enter any comments you wish to
record and your name.
The comments you enter will appear in the Comments box on the
Library Info tab of Library Manager when you select the library
on the Library Names tab. The name you enter will appear in the
Created By readout on the Library Info tab when you select the
library on the Library Names tab.

5. Add more information about your library.
You can continue entering information about the new library by
clicking Next. The Wizard lets you enter information about
spectral range, resolution and blanked areas for searching. For
this example, click Next in each window.

6. When you have completed entering information, click Finish.
When you click the Finish button, your library is created. You
can see the library listed by clicking the Search Libraries book on
the Library Names tab of Library Manager.
?
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In OMNIC Help Topics find “library, creating” in the Index and
go to “Creating a user library” for more information on creating
libraries.

Spectrometer Basics
This chapter describes the major components of your Nexus 870
spectrometer, including the light source, beamsplitter and detector. It
then explains what you will need to know before collecting data in
various spectral ranges.
In the Spectrometer Tour (available through Getting Started) view
“From the front,” “The back panel” and “Inside the spectrometer”
for complete descriptions of your spectrometer’s internal and
external components.

Spectrometer
components

The following illustration identifies some major components visible
on the outside of the spectrometer.

Sliding door

SST connectors
Status indicators

Detector fill ports

Beamsplitter
compartment

Detector
compartment

Emission port for
external source
Sample
compartment

External beam port
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Whats inside?

Choose SST Help Topics from the SST menu to find complete
information about using the SST connectors.

The illustration below shows a top view of the optical layout of the
spectrometer with covers removed to reveal components.

Interferometer

Laser

Beamsplitter
Beamsplitter
storage
Fixed mirror
or optional
emission optics

Electronics

External
emission port
Passport optics
(optional)

External
beam port

External
beam port

Back
detector

Aperture

Detector
mirror

Infrared source

Front detector
Near-IR source
Sample
compartment

Sample holder

Energy screen
or filter (optional)

Fixed mirror or optional
SeaPort optics

In the Spectrometer Tour (available through Getting Started) view
“Inside the spectrometer” for complete descriptions of your
spectrometer components.
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Viewing the optical layout
and beam path in OMNIC

You can view an image of the optical layout showing the current
beam path through the system by choosing Show Optical Layout
from the Collect menu. Here is an example:

The beam path is
indicated by a thick red line.

You can select a different view of the layout from the Viewpoint
drop-down list box. If you click the left or right arrow buttons, the
view changes in steps.
To see what type of detector or source is installed in a location, move
the mouse cursor over the image of the component. To select a
detector or source, click it. The beam path changes to reflect your
selection.
?

In OMNIC Help Topics find “optical layout” in the Index and go to
“Displaying the optical layout” for a complete description of this
feature.
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What is on
the rear panel?

The illustration below shows the locations and uses of the connectors
and the reset button on the spectrometer rear panel:

Connectors for
controlling external
accessories

Resets
spectrometer

Optional connectors for
passing signals between
rear panel and sample
compartment

Connector for external Connector for cable
DC power supply
from computer

Connector for Remote
Signals Accessory

Warning

Improper or unsafe cabling can cause damage to system hardware
and may create a safety hazard. Nicolet is not responsible for damage
or injury resulting from improper or unsafe cabling. ▲

Note

Use the Reset button when you are instructed to reset the
spectrometer by the troubleshooting procedures found in this manual
and elsewhere in the system documentation. ▲
In the Spectrometer Tour (available through Getting Started) view
“The back panel” for complete descriptions of the rear panel
components.
For more information about the Auxiliary pass-through connectors,
see the “How to cable an accessory” section of the “Accessories”
chapter.
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Turning on the
spectrometer power

Follow these steps to turn on the spectrometer power:
1. If the external power supply is not already connected,
connect it.
In the Spectrometer Tour (available through Getting Started)
view “Connecting to AC power” in the “Powering up” unit for
information on connecting the power supply.

2. Turn on any accessories you plan to use.
This includes accessories such as a gas chromatograph, a GC
interface or an infrared microscope.

Warning

Always follow the safety precautions in this manual and in the
Spectrometer Safety Guide that came with your system whenever
you use the spectrometer. ▲
3. Turn on the spectrometer by pressing the power switch (I/O)
on the external power supply to I.

To turn the spectrometer
off, press the switch to O.

Power switch
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When you turn on the spectrometer, the four status indicators—
Power, Scan, Laser and Source—flash in various sequences as
the system runs through its diagnostic routines. When the
routines are finished, the Power, Laser and Source indicators stay
lighted. The Scan indicator flashes with each scan of the
interferometer.
Note

After you turn on the spectrometer, let it stabilize for 15 minutes
(one hour for best results) before collecting data. Leave the
spectrometer on at all times, unless the building is subject to power
outages or you need to perform a service or maintenance procedure.
Leaving the spectrometer on increases stability and consistency of
performance. ▲

4. Turn on the printer and then the computer.
Turn on the printer and computer as explained in the
documentation that came with those components.

Reverse the order given in the preceding procedure when you turn
off system components:
1.
2.
3.
4.

Turn off the computer.
Turn off the printer.
Turn off the spectrometer.
Turn off the accessories.

In the Spectrometer Tour (available through Getting Started) view
“Powering Up” for complete instructions on turning on your system.
Note
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The system enters a “long-stroke” mode 10 minutes after data
collection activity has ceased. This mode continues for 1 hour. After
1 hour, the interferometer stops scanning and the Scan light stays on.
Any data collection activity will cause the interferometer to begin
scanning. Exiting OMNIC also activates the long-stroke mode. ▲

Note

If the Power, Laser or Source indicators flash or will not light at all,
or if the Scan indicator will not light, the Bench Status indicator will
show a red X and troubleshooting tips will appear on the screen. If
you cannot resolve the problem by following these tips, by pressing
the Reset button on the rear panel or by turning the spectrometer
power off and then on, contact Nicolet at one of the numbers below.
Outside the U.S.A. call your local sales or service representative.
Telephone numbers for all Nicolet Customer Support offices are
provided with your system.

•
•
•
•

Telephone (U.S.A.):
Fax:
World Wide Web:
E-mail:

1-800-NICOLET (1-800-642-6538)
1-608-273-5045
http://www.nicolet.com
nicinfo@nicolet.com ▲
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Using a light source

The Nexus 870 has an IR source and a near-IR source. You can
switch between different internal sources simply by changing the
Source setting on the Bench tab of the Experiment Setup dialog box.
This option lets you collect spectra in the mid-IR to far-IR range or
in the visible to near-IR range. The spectral range is determined by
the source, beamsplitter and detector you are using.
In Spectrometer Help Topics view “Installing a new source” in
“Setting up experiments” if you need to install or change a source.

Warning

Even after the spectrometer is turned off, the external housings of
working IR sources remain hot for up to 15 minutes. To avoid being
burned by a currently installed source, allow enough time for it to
cool before handling it. ▲
Nexus 870 spectrometers with the emission accessory can use an
external source if one is available. The beam from the external
source passes through the emission port on the right side of the
spectrometer.

?

58

Nicolet

In OMNIC Help Topics find “source” in the Index and go to
“Specifying the source type” for instructions on using different
sources in your spectrometer.

Using beamsplitters
and detectors

A number of beamsplitters and detectors are available for use in the
Nexus 870. Not all beamsplitters and detectors can be used together.
Some detectors can accommodate only a portion of the energy from
the source and require changing the aperture size or installing an
energy filter. This section explains how to select and optimize the
performance of beamsplitters and detectors.
In Spectrometer Help Topics view the appropriate lesson in “Setting
up experiments” if you need to install or change a beamsplitter or
detector.
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Selecting the right
beamsplitter and detector

There are two considerations when selecting a beamsplitter-detector
combination: compatibility and spectral range.
The following table shows which beamsplitter-detector combinations
perform best and which are compatible. Combinations are
considered compatible if they provide a detector signal that is large
enough to allow the beamsplitter to be aligned. This does not
necessarily mean a particular combination will provide the
maximum capable sensitivity range of each component.

BEAMSPLITTER
Near-IR
DETECTOR

Quartz

DTGS
(KBr window)**

X

DTGS
(Csl window)

Mid-IR*

Far-IR

XT-KBr

KBr

Csl

Solid Substrate

OK

Best

Best

OK

X

X

X

OK

OK

Best

X

DTGS
(PE window)

X

X

X

X

OK

Best

MCT-A

OK

OK

Best

Best

OK

X

MCT-B

OK

OK

Best

Best

OK

X

InSb

OK

Best

OK

X

X

X

PbSe

OK

Best

OK

X

X

X

Si

Best

OK

X

X

X

X

PbS

OK

Best

X

X

X

X

InGaAs

OK

Best

OK

X

X

X

CaF2

Best = Optimum beamsplitter-detector combination.
OK = Compatible beamsplitter-detector combination.
X = Incompatible beamsplitter-detector combination.
* A ZnSe beamsplitter may also be used as a mid-IR beamsplitter in extremely
humid environments.
** Valid for room temperature and thermoelectrically cooled versions.
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The next table lists the spectral ranges of compatible beamsplitterdetector combinations.

Spectral Range (cm-1)

Light Range

Beamsplitter

Detector

visible

quartz

PbSe
Si†

13,000 - 2,800*
25,000 - 8,600

Ever-Glo, white light
White light

CaF2

PbSe
Si†

13,000 - 2,000*
14,500 - 8,600

Ever-Glo, white light
White light

quartz

MCT-A‡
MCT-B‡
InSb‡,§
PbSe
PbS TEC (with SabIR)
InGaAs

11,700 - 2,800*
11,700 - 2,800*
11,500 - 2,800*
13,000 - 2,800*
10,000 - 4,200*
12,000 - 3,800

Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light

CaF2

MCT-A‡
MCT-B‡
InSb‡,§
PbSe
PbS TEC (with SabIR)
InGaAs

11,700 - 1,200*
11,700 - 1,200*
11,500 - 1,850*
13,000 - 2,000*
10,000 - 4,200*
12,000 - 3,800

Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light

XT-KBr

MCT-A‡
MCT-B‡
InSb‡,§
PbSe
DTGS-KBr
DTGS TEC
InGaAs

11,000 - 600*
11,000 - 400*
11,000 - 1,850*
11,000 - 2,000*
11,000 - 375*
11,000 - 375*
12,000 - 3,800

Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light
Ever-Glo, white light

near-IR

Source

Continued on next page...
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Spectral Range (cm-1)

Light Range

Beamsplitter

Detector

mid-IR

KBr

DTGS-KBr
MCT-A‡
MCT-B‡
DTGS TEC
DTGS-CsI

7,400 - 350
7,400 - 600
7,400 - 400
7,100 - 350
6,400 - 350

Ever-Glo
Ever-Glo
Ever-Glo
Ever-Glo
Ever-Glo

CsI¶

DTGS-CsI
MCT-A‡
MCT-B‡

6,400 - 200
6,400 - 600
6,400 - 400

Ever-Glo
Ever-Glo
Ever-Glo

ZnSe

DTGS-KBr
MCT-A‡
MCT-B‡
DTGS TEC
DTGS-CsI

4,000 - 650
4,000 - 650
4,000 - 650
4,000 - 650
4,000 - 650

Ever-Glo
Ever-Glo
Ever-Glo
Ever-Glo
Ever-Glo

700 - 50
700 - 20

Ever-Glo
Ever-Glo

far-IR

Solid-Substrate DTGS-PE
Si bolometer

Source

Notes:
* This spectral range reflects the combination of the ranges of the Ever-Glo and white light sources, as well as the limits of the
beamsplitter-detector combination. The range achieved using one of these sources will not be as broad as the total range shown.
† Si detectors can be used only with a white light (tungsten-halogen) source.
‡ These detectors must be cooled with liquid nitrogen before use.
§ InSb detectors will not produce a signal under intense light. During installation and alignment, start with the smallest aperture setting.
¶ CsI beamsplitters are extremely hygroscopic (sensitive to moisture).

Optimizing
the performance
of your detector

62

Nicolet

Nexus 870 detectors can be optimized to produce a more linear
response and greater photometric accuracy, or to increase the
signal-to-noise ratio. You can achieve these improvements in
performance by adjusting the amount of infrared energy that reaches
the detector.

Improving linearity
and photometric accuracy

Some detectors (including PbSe, Si, MCT-A and InSb detectors) are
highly sensitive and can become saturated or produce a distorted
(non-linear and photometrically inaccurate) signal if the light energy
is not reduced before it reaches the detector element.
Look at the low-end region of a single-beam spectrum (below the
low-end cutoff); you should see a straight line very near 0. As a rule
of thumb, the distance from 0 to the baseline should be less than 1%
of the spectrum’s maximum intensity value. If the detector is
saturated, you will see false energy in the low-end region. The
baseline might be far above zero.

Note

The maximum intensity of a mid-IR single-beam spectrum is
typically found near 2,000 cm-1. ▲
The distorted signal may cause problems with photometric accuracy.
For good quantitative data, the sample and background
interferograms should be about the same size. Scattering samples and
very dense samples produce very small signals that can result in
distorted quantitative data if the background signal is very large.
Check the low-end region or the background and sample
interferograms. If you see a substantial difference in their size,
photometric accuracy could be a problem.
To solve these problems, Nexus 870 spectrometers allow the
following options for modifying the infrared beam:

• Install a bandwidth-limiting filter.
• Install an energy screen.
• Adjust the aperture.
In Spectrometer Help Topics view “Setting up experiments” for
instructions on installing filters and energy screens.
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In some cases, system performance improves if you use a filter or
screen. The filter or screen that you should use for your application
depends on the samples being measured and other experimental
conditions. Try using various filters or screens to determine which
give the best results for your application.

When to use
bandwidth-limiting filters

Use bandwidth-limiting filters to improve the signal-to-noise ratio of
the data and also prevent detector saturation by allowing only energy
in your particular area of interest to pass to the detector element.
In Spectrometer Help Topics view “Installing an optical filter” in the
“Setting up experiments” book for instructions on installing filters.

When to use energy screens

Depending on the types of detectors you use, your system may include
a set of four energy screens. These metal screens help prevent detector
saturation and signal distortion by blocking out a portion of the energy
at all frequencies of the infrared beam. If your experiments deal with
information from a broad range of frequencies, these screens may be
the most effective means of reducing the light level.
The energy screens are labeled A, B, C and D. The following table
shows the percentage of the infrared energy that each screen passes.
It also lists the detectors typically used with each screen, as a starting
point for correcting linearity problems.
Screen

% Transmitted*

none
A
B
C
D

100
30
10
3
1

Detectors Typically Used With Screen
DTGS, MCT-B
MCT-A
PbSe, InSb, InGaAs

* These are nominal values that may vary due to diffraction and detector variations.
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To correct for photometric accuracy, you may need to add a “heavier”
screen (one that transmits less infrared energy). With corrections for
photometric accuracy you will notice some reduction in the signal-tonoise ratio but will obtain more reliable quantitative data. Generally,
the signal-to-noise ratio is reduced less than is the signal intensity.
In Spectrometer Help Topics view “Installing an energy screen” in
the “Setting up experiments” book for instructions on installing
energy screens.

What aperture size to
use for your detector

The aperture is a variable-diameter opening that controls the angular
size of the infrared beam and, thus, the amount of radiation that
reaches the sample. Using an aperture has these advantages:

• It lets you use more sensitive detectors.
• It helps prevent infrared energy saturation, so the response of the
detector is more linear.

• It improves wavenumber accuracy and resolution by acting as a
point source of infrared radiation.
In general you will find that the larger the aperture, the better is the
signal-to-noise ratio of the collected data. The smaller the aperture,
the better the stability and accuracy will be. Small apertures are
needed for high-resolution experiments.
DTGS detectors can accommodate most of the energy from the
source, which means you should use a large aperture size. Detectors
that require cooling with liquid nitrogen are very sensitive and
require a small aperture size or the use of an energy screen (see the
preceding section for more information).
Note

On Nexus spectrometers, the setting of the Aperture parameter
determines the area of the aperture opening. Doubling the setting
approximately doubles the area. A setting of 100 gives a nominal
aperture diameter of 8 mm and an approximate area of 0.50 cm2. ▲
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The following table lists recommended aperture settings for different
detectors with the appropriate energy screen installed. (See the
preceding section for information on the correct energy screen to use
for each detector type.) The settings in the table are based on the
physical size of the detector elements and maximize the amount of
infrared energy that reaches the sample. To correct linearity and
photometric accuracy problems, you can reduce the setting, but you
will pay a price in terms of the signal-to-noise ratio.

Detector
DTGS
MCT-A, MCT-B, InSb, PbSe, Si, InGaAs

?

How to improve the
signal-to-noise ratio

Aperture Setting
100
32

In OMNIC Help Topics find “aperture” in the Index and go to
“Setting the aperture size” for information on changing the aperture
setting.

If you primarily analyze qualitative data, you may wish to optimize
the system for a better signal-to-noise ratio. This can be particularly
important when you are working with scattering samples and
samples that absorb more infrared energy. These samples produce
smaller signals that can be “lost” in the noise.
There are several ways to improve the signal-to-noise ratio. The most
commonly used method is to increase the number of scans. This both
reduces the noise level and makes small absorptions easier to
distinguish. You can also improve the ratio by reducing the
resolution (using a larger Resolution setting).
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Another method is to use an energy screen that transmits more light
(or no screen at all). In this case, the resulting spectrum might be
distorted and accuracy and stability could be reduced. Checking the
single-beam baseline in the region below the low-end cutoff will
give you a rough idea of how much distortion is occurring. If the
distance from the baseline to 0 is more than 15% of the spectrum’s
maximum intensity value, you may have difficulty reproducing the
results.
Note

If the distance from the baseline to 0 is greater than 20% of the
spectrum’s maximum intensity value, your detector electronics may
be overloaded. Contact Nicolet Customer Support for assistance. ▲
In Spectrometer Help Topics view “Setting up experiments” for
instructions on installing filters and energy screens.

How to improve
the resolution

?

If you want to achieve higher resolution, you may need to use a smaller
aperture setting and an energy screen that transmits more light (or no
screen at all). Your spectroscopy software will automatically change
the aperture setting if a smaller beam size is required. Be aware that the
smaller beam size will reduce the signal-to-noise ratio.
In OMNIC Help Topics find “aperture” in the Index and go to
“Setting the aperture size” for information on changing the aperture
setting.
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How to collect
data in the visible
spectral range

The ability of the spectrometer to collect data is affected by the
detector-beamsplitter combination and any energy screens or optical
filters that are installed in the spectrometer. For example, if you use an
optional quartz beamsplitter, a silicon detector and a white-light
source, the sampling range is extended to 25,000 cm-1.
Since silicon detectors are very sensitive, you will also need to install
an energy screen or bandwidth-limiting filter to prevent the detector
from being saturated during the experiment. The following table lists
a variety of spectral bands in the extended spectral range and lists the
filter or energy screen that should be used to obtain data in each
range. It also lists typical aperture and gain settings for experiments
in each range.

Spectral Range

Filter or Screen

16,000 - 9,000 cm-1
16,000 - 9,000 cm-1
23,000 - 16,000 cm-1
26,000 - 21,000 cm-1

red filter
energy screen A
broad-band blue filter
narrow-band blue filter

Aperture Gain
32
32
100
100

1
1
8
8

You can use these filters and settings as a starting point and vary
them as required by your experimental conditions. To set the
aperture and gain, set the Aperture and Gain parameters on the
Bench tab in the Experiment Setup dialog box.
In Spectrometer Help Topics view “Installing an optical filter” in the
“Setting up experiments” book for instructions on installing filters.
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How to collect
data in the extended
spectral range

With OMNIC SST, the true spectral sampling range of your
spectrometer has been extended to 31,596 cm-1. You can make use of
this range by setting Sample Spacing on the Advanced tab of the
Experiment Setup dialog box to 0.5 whenever you specify a spectral
range (on the Bench tab of the Experiment Setup dialog box) that
exceeds 15,798 cm-1. When you use a sample spacing of one-half, four
data points are collected during one laser period. (A setting of 1
collects data twice, a setting of 2 collects data once, and a setting of 4
collects data once for every two laser periods.)
Using a higher setting of Sample Spacing results in fewer collected
data points, which allows you to use a faster scan velocity. With this
increase in velocity, less time is required for data collection.

Note

In step-scan experiments, you can use the sample spacing setting
alone to shorten collection time. ▲
There are some constraints on using sample spacing to shorten data
collection time and still collect valid data. For example, the Sample
Spacing parameter determines the nominal free (also known as
nonaliased or nonambiguous) spectral range that you can reliably
study, due to the Nyquist, or Sampling, theorem. The Nyquist theorem
states that at least two data points must be collected per period if you
wish to reproduce the waveform accurately from discrete sampling.
Since a 15798 cm-1 frequency laser is used to trigger data collection,
sample spacing limits the free spectral range for your interferogram
as follows.

Sample Spacing
0.5
1
2
4

Nominal Free Spectral Range
31,596 to 0 cm-1
15,798 to 0 cm-1
7,899 to 0 cm-1
3,949 to 0 cm-1
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If you allow energy from outside the free spectral range to reach the
detector, you will find that it corrupts your data with false energy. To
prevent this corruption, use an optical filter to prevent the unwanted
energy from reaching the detector and use an appropriate
beamsplitter-detector combination.
As an example, OMNIC uses a sample spacing of 2 for all
experiments where the data is collected in the region below
7899 cm-1. You can run these experiments using the standard
DTGS/KBr detector-beamsplitter combination, since this
combination passes no energy above 7899 cm-1. No additional
optical filters are required in this case.
However, if you are studying only data below 3940 cm-1, you can
use the sample spacing setting (along with the Velocity parameter) to
cut the data collection time in half with little or no effect on the
signal-to-noise ratio. For these experiments you would set Sample
Spacing to 4 and prevent energy above 3940 cm-1 from reaching the
detector.
?

In OMNIC Help Topics find “sample spacing” in the Index and go to
“Specifying the sample spacing” for more information about Sample
Spacing.
There are several ways to prevent unwanted energy from reaching the
detector. The most common is to install a 3940 cm-1 low-pass optical
filter in the beam path. In Spectrometer Help Topics view “Installing
an optical filter” in the “Setting up experiments” book for instructions
on installing filters.
As an alternative, you could install a band-pass filter (centered
around your particular region of interest). If you choose a band-pass
filter for use with a sample spacing of 4, make sure the upper limit of
the filter is 3940 cm-1 or lower. No filtering would be required for
experiments that pass no energy above 3940 cm-1 to the detector.

Note
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If you do not have a 3940 cm-1 or 1900 cm-1 low-pass filter, you can
order one from Nicolet. ▲

Scan velocities

To allow you to collect data faster, OMNIC SST and your Nexus 870
spectrometer support increased linear scan velocities, up to 8.2277 cm/s.
These higher velocities are useful for experiments where the sample is
likely to change over time. The highest of these velocities will be used
when you perform rapid-scan experiments using OMNIC Series.
While a wide range of moving mirror velocities are available on the
Nexus 870, some velocity settings cannot be used for collecting data
at certain combinations of spectral range and resolution. The
following tables show which velocity settings (in cm/s) are available
for different resolution settings (in wavenumbers) under the specified
conditions. A check mark (✓) indicates that the setting is available; a
dash (—) indicates that the setting is not available.

Sample spacing is set to 4 or 2, or the upper limit of the spectral range is less than or equal to
7899 wavenumbers:
Resolution J

0.125

0.25

0.5

1.0

2.0

4.0

8.0

16.0

32.0

0.0158 5.6961

✓

✓

✓

✓

✓

✓

✓

✓

✓

6.3290

—

—

✓

✓

✓

✓

✓

✓

✓

6.9619

—

—

—

—

✓

✓

✓

✓

✓

7.5948

—

—

✓

✓

✓

✓

✓

✓

✓

8.2277

—

—

—

—

—

✓

✓

✓

✓

Velocity L
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Sample spacing is set to 1, or the upper limit of the spectral range is within the range 7900 to
15798 wavenumbers:
Resolution J

0.125

0.25

0.5

1.0

2.0

4.0

8.0

16.0

32.0

0.0158 2.5317

✓

✓

✓

✓

✓

✓

✓

✓

✓

3.1647 3.7974

—

—

—

✓

✓

✓

✓

✓

✓

4.4303

—

—

—

—

—

—

✓

✓

✓

4.7468 5.6961

—

—

—

—

—

—

—

✓

✓

6.3290

—

—

—

—

—

—

—

—

✓

6.9619 8.2277

—

—

—

—

—

—

—

—

—

Velocity L

Sample spacing is set to 0.5, or the upper limit of the spectral range is within the range 15799 to
31596 wavenumbers:
Resolution J

0.125

0.25

0.5

1.0

2.0

4.0

8.0

16.0

32.0

0.0158 1.2659

✓

✓

✓

✓

✓

✓

✓

✓

✓

1.8988

—

—

—

—

—

✓

✓

✓

✓

2.5317

—

—

—

—

—

—

—

—

✓

3.1647 8.2277

—

—

—

—

—

—

—

—

—

Velocity L
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To specify the velocity and spectral range, set Velocity and Spectral
Range on the Bench tab of the Experiment Setup dialog box. To
specify the resolution, set Resolution on the Bench tab.
Important

Note

Slow scan

When you switch to a different detector or beamsplitter, OMNIC
automatically resets the default spectral range in the Experiment
Setup dialog box. Be sure to check the range and set the velocity to a
value that is appropriate (see the limitations described above). ▲
When collecting rapid scan data with a sampling interval of less than
0.04 second, do not interact with the computer (with the mouse or
keyboard) until the collection is finished; otherwise, Windows may
interrupt the collection. The current sampling interval is shown on the
Collect tab of the Series Setup dialog box and is calculated from the
resolution, mirror velocity and number of scans per spectrum or
interferogram. ▲

Slow scan allows the moving mirror to be precisely controlled at very
low velocities. Among other applications, this is particularly useful for
photoacoustic experiments. Slow scan is an experimental technique
and we invite you to explore new applications.
As with other linear applications, data in slow-scan applications is
collected continuously, as the moving mirror travels at a constant
velocity within the interferometer. Each light wave is modulated
individually, with the modulation frequency equal to the mirror
velocity multiplied by the wavelength of the light wave.
Due to the low velocities, you will notice a decrease in the
signal-to-noise ratio in slow-scan experiments. You can improve it
by increasing the number of scans.
No special hardware setup is required for slow-scan experiments.
Nearly any hardware you use for other linear scan experiments can
be used for slow-scan experiments. Some experiments that are
usually run in step-scan mode (such as photoacoustic spectroscopy)
can also be run using slow-scan.
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Note

Reduce the aperture setting or use an appropriate filter or screen
when running slow-scan experiments to prevent saturating the
DTGS, photoacoustic or other thermal detector. If you are not using
a filter or energy screen, an aperture setting of 2 is common for slowscan experiments. ▲
View “What is slow scan?” in the “Welcome to Nexus 870!” unit of
the Spectrometer Tour (available through Getting Started) for an
overview of slow-scan applications.

A note about vibrations

All slow-scan experiments are prone to disruption from vibrations.
Should your experiment be disrupted, the Nexus 870 spectrometer will
automatically recover. You do not need to restart the data collection.
If your experiment is disrupted by vibration, you can expect to hear a
clicking sound as the moving mirror is repositioned. This may take a
minute or two. Once the mirror is repositioned, data collection will
resume from the last valid scan.

Running
slow-scan experiments

The slow-scan capabilities are available on the Bench tab of the
Experiment Setup dialog box.
Use the Velocity setting on the Bench tab to access slow scan.
Selecting any of the velocities below 0.1581 cm/s puts the
spectrometer in slow-scan mode. Use Collect Sample and Collect
Background in the Collect menu to start your slow-scan experiments.
When you finish running slow-scan experiments, use Experiment
Setup to change the Velocity setting to 0.6329 cm/s or higher. This is
especially important if your next experiment will be a step-scan
experiment. The spectrometer cannot automatically shift from
slow-scan mode to step-scan mode.
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Using the SST Software
The SST menu in OMNIC gives you access to the SST experiments
that are available on your system. This chapter provides specific
information for using the software to perform each experiment.
View “What is SST?” in the “Welcome to Nexus 870!” unit of the
Spectrometer Tour (available through Getting Started) for an overview
of the SST software.

Starting the
SST software

Follow these steps to start the SST software:
1. Start OMNIC.
Double-click the OMNIC E.S.P. shortcut on the Windows desktop.
Depending on how the program has been configured, dialog
boxes may appear asking for a user name and password. Type
your user name if requested, and then choose OK. Enter a
password if required.
The OMNIC window appears.
2. Set the experiment parameters.
You can do this in one step by selecting an experiment from the
Experiment drop-down list box near the top of the window.
You can also use Experiment Setup in the Collect menu to open an
experiment or set the parameters individually. These parameters
include File Handling and Background Handling on the Collect tab
and Sample Compartment, Detector, Beamsplitter, Source and
Aperture on the Bench tab of the Experiment Setup dialog box.
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3. Click SST in the menu bar to display the SST menu
commands.

On-line Help for SST

You can access on-line Help for the SST software by choosing SST
Help from the SST menu. Also, if you press the F1 function key
while you are in any SST dialog box or window or while any SST
menu command is highlighted, the on-line Help information for that
item appears.

Collecting
data with SST

After you have started the SST software, you can use the commands
in the SST menu to collect sample and background data. Follow
these steps:
1. Choose the technique you wish to use from the SST menu.
The menu lists the experiments that are available for your
spectrometer.

Note

Time-Resolved Step Scan experiments are available if you purchased
the optional OMNIC SST with TRS Experiments software package. ▲

2. When the setup dialog box for the SST technique appears, set
the parameters for your experiment.
Note

If you change the spectral resolution, points before peak, or sample
spacing parameters using one of the SST setup screens, it changes
that parameter for all SST and standard OMNIC data collection
techniques. ▲

3. When the software is set up for your experiment, choose OK.
You are returned to OMNIC.
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4. Use the commands in the SST menu to collect your
background or sample data.

Ratioing spectra

Note

Ratioing spectra
against a common
stored background

The Ratio Spectra command in the SST menu allows you to perform
spectral division, ratioing any one spectrum or a group of three or
more spectra against a common background spectrum. The
background spectrum must be stored on a disk. You may also ratio
two active spectra against each other.
Whenever you ratio spectra, all of the spectra you select must be in
the same final format. For example, you cannot ratio an absorbance
spectrum against a transmittance spectrum. ▲

Follow these steps to generate a ratioed spectrum from a stored
background:
1. Open any spectrum.
If you wish to ratio a group of spectra, open all of the spectra
into one spectral window.

2. Select the spectra you wish to ratio.

3. Choose Ratio Spectra from the SST menu.
The Ratio Spectra dialog box appears.

4. Select the spectrum to be used as the denominator.
Use the Browse button to locate and select a background
spectrum that you previously saved on a disk.
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5. Select the destination for the ratioed spectra.

6. Choose OK to generate the ratioed spectrum.
The results of the ratio operation appear in the window you
selected.
Note

The special case of
ratioing only two spectra

Choose Cancel to exit the dialog box without ratioing the spectra. ▲

When you use the Ratio Spectra command with only two singlebeam spectra selected, the command operates a bit differently. It
generates a ratioed spectrum from those spectra. In this case, you do
not have the opportunity to select a stored background spectrum. If
you need to ratio only two spectra against a stored background, ratio
each of them separately.
Follow these steps to generate a ratioed spectrum from two selected
spectra:
1. Open and select the two single-beam spectra you wish to
ratio.

2. Choose Ratio Spectra from the SST menu.
The Ratio Spectra dialog box appears. Here is an example:
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3. If the spectra are not correctly positioned as numerator and
denominator, click the Swap button at the right.

4. Choose OK to generate the ratioed spectrum.
Choose Cancel to exit the dialog box without ratioing the spectra.
The results of the ratio operation appear in the spectral window.

Using SST phase
array operations

Phase array operations allow you to reprocess (using the commands
in the OMNIC Process menu) spectra collected using PM step-scan,
PEM and other experimental techniques that generate two or more
spectra from the same scan. You can also use them to view and
manipulate phase correction arrays for other spectra.

What is a phase array?

A phase array is a frequency-dependent list (or spectrum) of phase
angles calculated from the Fourier transform of an interferogram
truncated about the central peak maximum. Each phase angle in the
array is defined by the following equation:

φ i = arctan(Ii / Ri )
where Ii and Ri are the imaginary and real points from the Fourier
transform at frequency i.
The phase array is used to correct the full-resolution single-beam
spectrum for phase shifts caused by optical differences in the
beamsplitter substrate and the compensator plates and for the
probability that the central peak maximum point is not at exactly the
zero-path-difference (ZPD) point.
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What is phase correction?

Phase correction is one of several operations performed on the data
collected by the detector. During the conversion of an interferogram
to a spectrum that can be analyzed, the apodization and zero filling
operations that you selected using Experiment Setup, the Fourier
transform operation, and the phase correction operation are
performed.
The phase correction is calculated using the following formula:
Xi = Ri cos φ i + Ii sin φ i
where Ri and Ii are the real and imaginary points from the Fourier
transform of the entire interferogram at frequency i, Øi is a phase
angle from the phase array (interpolated, if necessary), and Xi is the
single-beam spectrum.
In some experiments, such as PEM step scan, TRS step scan and PEM,
more than one interferogram is collected during a single scan. To
obtain valid data from these experiments, a single phase correction
array must be used for all the interferograms collected during the scan.
When you use the Collect Sample command in the SST menu, this is
handled automatically by the OMNIC SST software. When you
reprocess the data, the OMNIC software must be directed (using the
Phase Array Operations command in the SST menu) to use the same
phase correction array for all of the interferograms. If you do not
direct OMNIC to use a stored phase array, a new phase array will be
calculated from each interferogram.

Phase array operations
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The Phase Array Operations command in the SST menu lets you
calculate, store and use a stored phase array for correcting any
spectrum. You can also examine and manipulate the phase array
used for the correction. This is useful when you need to apply
different Y-axis constraints to the phase array.

Calculating a phase array

Follow these steps to calculate a phase array:
1. Save the interferograms when you collect the data.
There are two options for saving interferograms.
You can turn on Save Interferograms before beginning data
collection. This option is in the File Handling box on the Collect
tab in the Experiment Setup dialog box.
You can select Interferogram as your final format. The Final
Format parameter is on the Collect tab in the Experiment Setup
dialog box.

2. Open and select the interferogram.
If you selected Interferogram as your final format:
Use Open in the File menu to display the interferogram in a
spectral window. The interferogram is selected automatically.

If you chose to save the interferograms with your spectrum:
Use Open in the File menu to display the spectrum in a spectral
window.
Choose Reprocess from the Process menu.
Select Interferogram from the Final Format drop-down list box.
Choose OK. The interferogram appears in a spectral window.
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3. Choose Phase Array Operations from the SST menu.
The Phase Array Operations dialog box appears.

4. Choose Calculate Phase Array.

5. Configure OMNIC to use the stored phase array.
Turn on the Use Stored Phase Array check box and then choose
OK.

OMNIC will use that stored phase array to process all subsequent
interferograms until you turn the check box off or store another
phase array.
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Viewing a phase array

You must calculate the phase array before you can view it. Follow
these steps:
1. Choose Phase Array Operations from the SST menu.
The Phase Array Operations dialog box appears.

2. Choose View Phase Array.
The phase array appears in the active spectral window. You can
manipulate it using the commands in the Process menu. You can
then store the modified phase array and use it to generate spectra.
Refer to the OMNIC Help system if you are unfamiliar with the
Process menu commands.

Storing a phase array

You must calculate and view the phase array before you can store it.
Follow these steps:
1. Select the phase array.

2. Choose Phase Array Operations from the SST menu.
The Phase Array Operations dialog box appears.
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3. Choose Store Phase Array.
The phase array is stored in memory, from which you can use it
to process interferograms.
4. Configure OMNIC to use the stored phase array.
Turn on the Use Stored Phase Array check box and then choose
OK.

OMNIC will use that stored phase array to process all subsequent
interferograms until you turn the check box off or store another
phase array.

Saving a phase array

You must calculate and view the phase array before you can save it.
Follow these steps:
1. Select the phase array.

2. Save the phase array.
Use the Save As command in the File menu.
You will be prompted for a filename and directory path. Refer to
the OMNIC Help system and your Windows documentation if
you are unfamiliar with naming and saving files.
The phase array will be saved as a standard OMNIC spectral data
file. You can open it using any program that can read OMNIC
files.
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Accessories
This chapter briefly describes the types of sampling and system
accessories that are available for your spectrometer. Complete
descriptions and operating instructions are included with the
accessories.

Smart Accessories

In addition to traditional accessories, a variety of Smart Accessories
are available for your spectrometer. The Nexus system uses E.S.P.
technology to identify each Smart Accessory as soon as it is installed
and set the software parameters for data collection. Also, a series of
spectral quality checks are performed to ensure that the accessory is
installed and operating correctly.
In Spectrometer Help Topics view “Installing a Smart accessory” in
the “Installing optional hardware” book for instructions on installing
Smart Accessories.
Nexus Smart ARK – This is a horizontal ATR accessory with
high stability, complete purge capabilities, tool-free alignment and
high performance specifications. It includes integral purge tubes that
seal the accessory from the atmosphere, and an aluminum, cast body
for exceptional stability.
Nexus Smart Collector – Diffuse reflection enables analysis of
highly light-scattering solids that are difficult to analyze using
transmission techniques. This method is also useful when the
sample, usually a powder, must be analyzed without modification.
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Nicolet Near-IR FiberPort – This accessory is optimized for nearIR sampling. The probe combines input and collection fibers in a
unique sampling tip. In reflectance mode, solids and light-scattering
liquids can be analyzed through direct contact. Transflectance mode is
used for transparent liquids. This accessory is useful for the
nondestructive study of polymers, pharmaceuticals, foods, fabrics and
chemicals, as well as biological and environmental samples. The
accessory uses an optimized lead sulfide detector.
Nicolet Mid-IR FiberPort – This high-throughput accessory lets
you analyze liquids remotely. The needle probe can reach “hard to
get” samples, such as liquids in micro containers, hazardous
environments or remote locations. The FiberPort is a unique optical
interface that transfers IR energy from the spectrometer to the fiber
optic cables and probes. A complete line of fiber optic probes is
available for sampling a wide range of sample types.
Nicolet Smart MIRacle – This a single-reflection horizontal ATR
accessory with exceptional throughput and sensitivity. It can use
several crystal types and has a micrometer screw for precise control
of applied pressure.
Nicolet Smart DuraSamplIR – This single-reflection horizontal
ATR accessory has a viewing feature that makes it easy to position
the sample and monitor the applied pressure. The accessory is ideal
for small samples and can be used to measure liquids, powders and
pliable solids.
Nicolet OMNI-Sampler – This single-reflection ATR accessory
features a spherical crystal that lets you measure a wide variety of
sample types. The unique tower design automatically applies the
optimum pressure while protecting the crystal. The accessory is ideal
for analyzing very small samples or sample areas and provides high
reproducibility.
Nicolet OMNI-Transmission – This easy-to-install transmission
accessory lets you sample liquids, gases and solids using a wide
variety of transmission cells and infrared cards.
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Nicolet Near-IR UpDRIFT – This is a top-loading diffuse
reflection accessory designed for fast analysis of solids and powders.
In many cases you can analyze samples directly from plastic or glass
containers.
Nicolet Smart Golden Gate – This is a horizontal, single-reflection
ATR accessory that features an extremely durable diamond crystal. It
handles a wide range of sample types, including hard or brittle
solids, corrosive liquids and hard powders.
Avatar Single-Bounce HATR – This is a single-reflection
horizontal ATR accessory that has a shorter pathlength and higher
throughput than traditional HATR accessory design. It is the best
choice for routine analysis of strong infrared-absorbing samples.
This is an economical choice for quality control or academic
environments where routine analyses of neat solvents, aqueous
solutions, powders and film samples are required.
Avatar Multi-Bounce HATR – This is a multi-reflection horizontal
ATR accessory that has a shorter pathlength and higher throughput
than traditional HATR accessory design. It is the best choice for
routine analysis of strong infrared-absorbing samples. This accessory
is ideal for rapid quantitative and qualitative analyses, since sample
preparation is usually not necessary.
Avatar Diffuse Reflectance – The diffuse reflection technique lets
you analyze highly light-scattering solids that are difficult to analyze
using transmission techniques. The technique is also useful when the
sample, usually a powder, must be analyzed without modification.
This accessory lets you analyze a wide variety of sample types and
features integral sample cups for convenient, fast sampling.
?

In OMNIC Help Topics find “accessory” in the Index and go to
“Specifying the accessory” for instructions on setting up and saving
experiments for custom accessories.
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Other sampling
accessories for
different applications

You can install many of these sampling accessories yourself. After
you install an accessory, you might have to align it. Instructions for
aligning the spectrometer are included in the “Service and
Maintenance” chapter of this manual. Instructions for aligning an
accessory are provided in the documentation that came with that
accessory.
Most accessories fit into the sample compartment, but some require
separate housing and optics. Nicolet offers auxiliary experiment
modules, microscopes, gas chromatography interfaces and
thermogravimetric analysis interfaces with the Nexus 870.
Some accessories have their own optics. The optional mirror optics
inside the spectrometer redirect the light beam from the internal light
source through a port on the right side of the spectrometer. The beam
then travels into the accessory’s optics.
Some of the accessories fit into the sample compartment and require
that you remove the standard Snap-In baseplate before installing the
accessory. For information on using Snap-In baseplates, view
“Removing the Snap-In baseplate” in “Setting up experiments” in
Spectrometer Help Topics.
Call Nicolet if you are interested in ordering any of the following
sampling accessories.

Note

Additional Snap-In sample compartment baseplates are available for
use with each accessory to make changing accessories easier. ▲
Automatic sample wheel – This accessory holds multiple samples
and rotates them into the beam path for data collection. The sample
wheel is commonly used to measure multiple polymer or pressedpowder samples automatically.

88

Nicolet

Auxiliary experiment module (AEM) – The AEM provides you
with an additional sample compartment. You can position it on the
right or left side of the spectrometer. With an AEM installed, you
can run routine analyses with the spectrometer and quickly switch
beam paths to the AEM to collect data from other samples without
removing accessories from the main sample compartment. Any
accessory or detector that can be installed in the spectrometer can be
installed in the AEM. The AEM has two detector locations.
Continuµm, InspectIR and Advantage infrared microscopes –
Nicolet offers microscopes that attach directly to either side of the
spectrometer. Microscopes can also be installed between the
spectrometer and other accessory modules. The microscopes provide
fast, nondestructive microanalysis with minimal sample preparation
and alignment. The beam path is switched from the spectrometer to
the microscope module through the OMNIC software.
Custom accessory baseplate – You can use this Smart baseplate to
mount an accessory you have built or purchased from another
manufacturer. When you install the accessory and baseplate in the
sample compartment, the system automatically selects the Custom
Accessory experiment (or allows you to select from the experiments
you have saved for the baseplate).
Detector interface kit – A variety of accessories (that were
specifically designed for Nexus 870 spectrometers) contain detectors
that are automatically recognized by your spectrometer. The detector
interface accessory allows your spectrometer and OMNIC software
to recognize other detectors, including non-Nicolet detectors.
Gas cells – A variety of short- and long-pathlength gas cells are
available. Cells include built-in transfer optics that fit into your
spectrometer or AEM sample compartment. The cells are suitable for
use in both ambient and elevated temperature conditions. Gas cell
heating, transfer optics purge, gas manifold, and sample window
options are available to accommodate a variety of sample gases and
sampling conditions.

Nexus 870 User’s Guide

89

GC interface – This interface attaches to the right side of the
spectrometer and must be connected to a gas chromatograph (GC).
You can then analyze IR spectra from GC experiments using the
OMNIC Series software.
Gemini – By combining two sampling technologies—horizontal
attenuated total reflection (HATR) and diffuse reflection—this
accessory lets you analyze a broad range of sample types. The
Gemini is baseplate-mounted for high stability, and no accessory
realignment is necessary when you switch sampling heads. Integral
purge tubes seal the accessory from the atmosphere.
PAC 300 Photoacoustic E.S.P. – Photoacoustic spectroscopy (PAS)
is a powerful technique for the nondestructive spectroscopic analysis
of solid samples of all types. PAS is particularly applicable to
powders (including dark, highly absorbant samples), polymer pellets,
beads, and sheets and films. The PAC 300 Photoacoustic E.S.P.
accessory is fully integrated with the spectrometer and computer. It
automatically selects an OMNIC experiment, draws power right
from the spectrometer and includes an on-line tutorial.
PEM kits – A variety of PEM (photoelastic modulator) external
hardware kits include a lock-in amplifier, high-pass filter, the PEM,
transmission and grazing angle sample holders, a polarizer, transfer
and focusing optics, and optical filters. These kits contain all the
hardware needed to perform VCD (vibrational circular dichroism)
and PM-IRRAS (polarization modulation infrared reflection
absorption spectroscopy) experiments. The optional OMNIC SST
with PEM Experiments software package is required for these
experiments.
Remote Start accessory – This accessory adds external trigger
capability to your spectrometer. With a press of the Start switch, you
can control the start of data collection or coordinate the start of an
external experiment.
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Sample shuttle – A sample shuttle lets you collect background
spectra without removing the sample from the sample compartment.
The shuttle automatically moves the sample out of the beam path
before background collection begins. Since the sample compartment
cover is not opened, the system purge is maintained.
Specular reflection – Specular reflection provides a nondestructive
method for measuring surface coatings without sample preparation.
It can be used to analyze surface-treated metals, paints,
semiconductors, and resin and polymer coatings. Specular reflection
accessories can be installed in the spectrometer sample compartment
or AEM.
TGA interface – This interface is equipped with a built-in,
temperature-controlled flow cell and must be connected to a
thermogravimetric analysis (TGA) furnace. You can analyze the
evolved gases from TGA experiments using the OMNIC Series
software. The TGA interface is usually mounted in the sample
compartment of an AEM.
Transmission E.S.P. – Transmission is the oldest and most efficient
sampling technique in FT-IR spectroscopy and can be used for
sampling liquids, gases or solids. A variety of cells and sample
holders are available for transmission analysis. All can be mounted
in the spectrometer sample compartment or an auxiliary experiment
module.
TRS kits – Each TRS (time-resolved step-scan) kit includes a fast
transient data acquisition card, a high-speed photovoltaic MCT
detector and the OMNIC SST with TRS experiments software
package needed to perform a variety of time-resolved experiments.
Time-resolved measurements to 10 nanoseconds are possible.
Validation wheel – The validation wheel is used with Nicolet’s
System Validation software to validate the performance of the
spectrometer. The wheel automatically moves standard samples into
the beam path at the appropriate times during the validation procedure.
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System accessories

Some system accessories are installed by Nicolet. Call Nicolet if you
are interested in ordering any of the following accessories.
Power line conditioner – Power line conditioners protect your
spectrometer and other accessories from damage or malfunction due
to voltage dropouts, transient spikes, frequency shifts or other
disturbances in your electrical service.
Uninterruptable power supply – An uninterruptable power supply
reduces the chance of a system shutdown if power is lost elsewhere
in the building.
Pure air generator – Nicolet offers a complete dry-air generation
system. It includes an air compressor, a dryer, prefilters, a final
filter/moisture indicator, and flow controls. If you have difficulty
controlling moisture in your laboratory, the pure air generator
provides additional protection for the hygroscopic elements of your
spectrometer. This accessory is also useful if your laboratory
environment is contaminated with volatile solvents, oil or other
reactive materials.
Purge gas generator – If you do not have in-house facilities to
supply compressed air or nitrogen for system purge, Nicolet offers
several purge gas generators.
Smart Purge Kit – This kit adds enhanced purging capability to
your spectrometer. When you open the sample compartment cover or
its sliding door, Smart Purge automatically increases the purge gas
flow rate for a short time. This keeps water vapor, carbon dioxide
and other unwanted gases out of the spectrometer while you install
or remove a sample. You can then collect spectra without waiting for
proper purge to be restored.
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How to cable
an accessory

When you install an accessory in the sample compartment, you may
need to connect one or more cables from the accessory to connectors
on the rear wall of the compartment. You may also need to attach
cables from other peripherals (such as computers, custom controllers
or power supplies) to the accessory or from the accessory to the rear
panel of the spectrometer. The instructions that came with the
accessory should contain specific information on connecting that
accessory.
See the illustrations in the next sections for the locations of the
connectors.

Pass-through connectors

Warning

Your spectrometer may be equipped with pass-through connectors
for use with special accessories. These connectors allow you to make
accessory cable connections through the spectrometer. This
eliminates the need to run cables through the seal on the sample
compartment cover or out the top of the sample compartment.
Improper or unsafe cabling can cause damage to your accessory and
may create a safety hazard. Only qualified persons should cable a
custom accessory using these connectors. Nicolet is not responsible
for damage or injury resulting from improper or unsafe cabling. ▲
To use the pass-through connectors, connect the accessory inside the
sample compartment and connect the external power or
communications peripheral to the corresponding pass-through
connector on the rear panel of the spectrometer.
See the next sections for details.
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Connectors inside the
sample compartment

The following illustration shows the locations of the electrical
connectors inside the sample compartment:

Accessory connector for detector
signal or accessory control and power

Detector/Motors

Auxiliary
Purge
Out

Optional pass-through connector
for communication or other signal

Detector/Motors – If you have a photoacoustic or other accessory
that has a detector or motor located in the spectrometer sample
compartment, connect the cable from the detector or motor to this
standard connector. This is not a pass-through connector. See
“Detector/Motors connector” for information on using this connector
to connect custom hardware.
Auxiliary – Six pins on this optional connector can be used for
passing DC power input or other signals from the Auxiliary 1 and
Auxiliary 2 connectors on the rear panel to an accessory. For
example, the automatic sample wheel and the ProfilIR accessory get
DC power through this connector when the DC power output of an
AC-to-DC converter is attached to the Auxiliary 1 connector on the
rear panel. See “Using connectors for custom accessories” for
information on which pins are available for use.
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Connectors on the rear panel

The illustration below shows the optional connectors on the rear
panel that you can use to pass signals to and from the sample
compartment.

Pass-through connector
(for DC power input
or other signal)

Pass-through connector
(for communication
or other signal)

Auxiliary 1 – This connector passes power or other signals for the
accessory to three pins on the Auxiliary connector inside the sample
compartment. This connector could be used, for example, to attach
the DC output of an AC-to-DC converter to provide DC power to an
accessory in the sample compartment.
Auxiliary 2 – This connector passes signals to three pins on the
Auxiliary connector inside the sample compartment. This connector
could be used, for example, to allow an accessory in the sample
compartment to be controlled through your computer’s serial
(RS-232C) port.
See the next section for information on which pins are available for
use.
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Using the pass-through
connectors for
custom accessories

Warning
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By connecting custom cables that use the pins on the pass-through
connectors, you can provide power and communication or other
signals for your custom accessories. The power and signals pass
through the spectrometer from the rear panel to the sample
compartment and vice versa. Make sure your use of the connectors
complies with the voltage and current limitations given in the
following Warning.
Improper or unsafe cabling can cause damage to your accessory and
may create a safety hazard. Only qualified persons should cable a
custom accessory using these connectors. Do not pass signals that
exceed ±15 VDC through these connectors. You must also limit the
current to a maximum of 800 mA. Nicolet is not responsible for
damage or injury resulting from improper or unsafe cabling. ▲

The following diagram shows schematically which pins of the
Auxiliary connector inside the sample compartment are connected
internally to pins of the Auxiliary 1 and Auxiliary 2 connectors on
the rear panel. Since none of these connected pins are assigned by
the Nexus 870, they are available for use with custom accessories.

Rear Panel
Connectors

1 (male)

1

6

2

7

3

8

4

9

5

Sample Compartment
Connector

8

7

6

5

4

3

2

1

Auxiliary
9

6
7
8

2 (female)

9

10

1

11

2

12

3

13

4

14

5

15
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Detector/Motors
connector

You can use the Detector/Motors connector on the rear wall of the
sample compartment to connect your own detectors, accessory
motors and other custom hardware.

8

7

15

14

6

5

13

4

12

3

11

2

10

1

9

Detector/Motors

Make sure your use of the connector complies with the voltage and
current limitations given in the following Warning.
Warning
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Improper or unsafe cabling can cause damage to your accessory and
may create a safety hazard. Only qualified persons should connect a
cable to the Detector/Motors connector. Do not use this connector for
signals that exceed ±15 VDC. Limit the current to a maximum of
800 mA. Nicolet is not responsible for damage or injury resulting
from improper or unsafe cabling. ▲

The following table shows “pinout” information for the
Detector/Motors connector. Use this information when designing a
cable to connect your custom hardware to the connector. Refer to the
preceding illustration for the locations of the numbered pins.

Pin Number

Description

1

Do not use this pin.

2

Used by the sample shuttle motor (negative).

3

Positive 5 volts.

4

Analog ground.

5

Used by the sample compartment detector for
negative analog input.

6

Positive 12 volts analog.

7

Used by the sample compartment detector for digital
communication.

8

Positive 5 volts.

9

Used for sample compartment digital communication.

10

Used by the sample shuttle motor (positive).

11

Positive 12 volts.

12

Analog ground.

13

Used by the sample compartment detector for positive
analog input.

14

Negative 12 volts analog.

15

Used by the sample compartment detector for digital
communication.
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Quick Answers to Your Questions
About Using OMNIC
This chapter answers some common questions about using OMNIC.
Each answer is followed by a reference telling you where to go for
more information.

Collecting spectra

How do I set the software for collecting spectra?
You can set the software in one step by selecting a stored experiment
from the Experiment drop-down list box below the OMNIC window
menu bar. To set the experiment parameters individually, use
Experiment Setup in the Collect menu.
If you install a Smart Accessory, the system automatically sets the
software parameters (or a list of appropriate experiments is made
available for your selection), and you can begin collecting spectra.
Collecting a Spectrum (available through Learning OMNIC)...
“Preparing the Software”

?

?

In OMNIC Help Topics find “experiment” in the Index and go to
“Selecting an experiment” or “Using Experiment Setup.”
SST Help Topics in the SST menu
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How do I collect a spectrum?
Set the parameters as explained above and then choose Collect
Sample from the Collect menu. Depending on the parameter settings,
you may need to install or remove the sample before choosing
Collect Sample.
Collecting a Spectrum (available through Learning OMNIC)...
“Collecting the Spectrum of a Sample”
?

?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Collecting a sample spectrum” or “Collecting a background
spectrum.”
SST Help Topics in the SST menu

How do I specify the Y-axis unit for collecting spectra?
Choose Experiment Setup from Collect menu and then set Final
Format on the Collect tab.
You can change the format of a collected spectrum by using
Absorbance, % Transmittance or Other Conversions in the Process
menu. See the question and answer in the next section for a
description of the available units.
Collecting a Spectrum (available through Learning OMNIC)...
“Typical IR Transmission Spectrum”
?
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In OMNIC Help Topics find “units” in the Index and go to
“Selecting the final format.”

What does gain do?
Gain amplifies the detector signal intensity, making it larger relative
to the level of electronic noise. This is helpful when the signal is
weak, such as when you use some sampling accessories. You can let
OMNIC automatically adjust the gain to maximize the signal by
setting the Gain parameter to Autogain. We recommend using this
setting to ensure the best spectral quality.
?

In OMNIC Help Topics find “gain” in the Index and go to “Setting
the gain.”

When should I save interferograms with my spectra?
Save interferograms if you think you may want to restore the original
data after it has been processed or if you want to keep an archive of
your raw data.
Collecting a Spectrum (available through Learning OMNIC)...
“Preparing the Software”
?

In OMNIC Help Topics find “saving, interferograms” in the Index
and go to “File handling.”

What does the Collect Sample window show?
The window displays the “live” spectrum as it is being collected plus
a gauge indicating the progress of the collection, an indicator
showing whether any problems have occurred and other information
about the collection.
Collecting a Spectrum (available through Learning OMNIC)...
“Collecting the Spectrum of a Sample”
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?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Collecting a sample spectrum.”

How do I know my spectra are meeting quality standards?
OMNIC continuously monitors the quality of the data you collect,
based on the parameters you set. The Quality tab in the Experiment
Setup dialog box contains parameters for specifying the spectral
quality characteristics that you want checked when you collect
spectra.
OMNIC offers four categories of spectral quality checks:

•
•
•
•

Spectrum checks
Parameter checks
Background checks
Interferogram checks

When OMNIC performs a check and detects a problem, the Collect
Status indicator is displayed as a yellow circle or a red X. Click the
indicator (or click the View Collect Status button at the end of data
collection) to see a summary of data collection problems encountered
during the collection and other information about the collection.
When a collected spectrum passes all of the selected quality checks,
the Collect Status indicator appears as a green check mark.
?
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In OMNIC Help Topics find “quality” in the Index and go to
“Quality tab.”

Converting
spectra to other units

Which Y-axis unit should I use for a spectrum?
The most commonly used units are % transmittance and absorbance.
Use % transmittance if you plan to compare the spectrum visually
with published reference spectra. Use absorbance units for
quantitative analysis measurements.
Kubelka-Munk units are useful for searching diffuse reflectance
spectra against libraries of absorbance spectra.
Use photoacoustic units for spectra collected using a photoacoustic
accessory.
Percent reflectance units are mathematically equivalent to %
transmittance units, but using them for spectra collected using a
reflection technique serves to identify the technique.
Using log (1/R) units for spectra collected using a reflection
technique is useful for quantitative comparisons, since there is often
a linear relationship between the concentration of a component and
its log (1/R) value.
Collecting a Spectrum (available through Learning OMNIC)...
“Typical IR Transmission Spectrum”

?

In the OMNIC Help Topics Index...
Find “absorbance” and go to “Converting spectra to absorbance.”
Find “transmittance (%)” and go to “Converting spectra to
% transmittance.”
Find “Kubelka-Munk units” and go to “Kubelka-Munk units.”
Find “photoacoustic units” and go to “Photoacoustic units” topic.
Find “reflectance (%)” and go to “% Reflectance units.”
Find “log (1/R) units” and go to “Log (1/R) units.”
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Using
spectral libraries

?

How do I search a spectral library?
First prepare the spectrum (as explained below) and display or select
the region you want searched. Then set up the search using Library
Setup in the Analyze menu and start the search by clicking the
Search button in the Library Setup dialog box or by choosing Search
from the Analyze menu.
In OMNIC Help Topics find “library” in the Index and go to
“Setting up a library search” or “Searching a spectral library.”

How should I prepare my spectrum before searching it against a
spectral library?
There are several corrections you can perform on a spectrum to
obtain the best search results:

• If the baseline of the spectrum is sloped, curved or shifted
vertically, correct it using Baseline Correct in the Process menu.
?

In OMNIC Help Topics find “baseline” in the Index and go to
“Correcting a baseline manually.”

• If the spectrum has totally absorbing bands, eliminate them by
using Blank in the Process menu. Be careful not to blank regions
that contain other important spectral information.
?

In OMNIC Help Topics find “blanking spectral region” in the
Index and go to “Blanking a spectral region.”
You can also use the region tool to select a region of the
spectrum that does not include any totally absorbing bands or use
the view finder to display the region before searching. (These
methods avoid the loss of spectral information that results from
blanking.)
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?

In OMNIC Help Topics find “spectral region” in the Index and
go to “Region tool” or “View finder.”

• If you collected the spectrum using specular or diffuse reflection,
use Kramers-Kronig (dispersion) correction (available through
Other Corrections in the Process menu) to correct it for
dispersion effects and then search it against a library of
absorbance spectra.
?

In OMNIC Help Topics find “Kramers-Kronig transformation”
in the Index and go to “Kramers-Kronig (dispersion)
transformation.”

• If you collected the spectrum using ATR (attenuated total
reflection), use ATR correction (available through Other
Corrections in the Process menu) to correct it for variation in the
depth of penetration and then search it against a library of
transmission spectra.
?

In OMNIC Help Topics find “ATR correction” in the Index and
go to “ATR correction.”

• If the spectrum has water or carbon dioxide peaks, use Other
Corrections to remove these peaks.
?

In OMNIC Help Topics find “water” in the Index and go to
“H2O and CO2 correction.”
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Only those portions of the spectrum which are within the selected
region (or displayed region if no region is selected) and within any of
the regions you specified for the library using the Region Setup tab
of the Library Setup dialog box will be included in the search. If the
spectral range of the spectrum is broader than that of the library
spectra, use the region tool to select the region of the spectrum that
coincides with the library spectra before you start the search. You
can also use the view finder to display the region to search. The
Search command operates on the selected region, or on the displayed
region if a region is not selected.
?

In OMNIC Help Topics find “spectral region” in the Index and go to
“Region tool” or “View finder.”

How do I create a spectral library?
Use the Create Library button on the Library Names tab of Library
Manager to create a user library.
Once a library is created, you can add spectra to it with the Add To
Library button, with Add To Library in the Analyze menu, or by
dragging the spectrum to the library’s book on the Library Names
tab of Library Manager. You can use a search library you create just
as you would a commercial library to identify unknown spectra. You
can use a QC library to verify the composition of a sample. If you
create a scrapbook library, you can find spectra in it by searching for
text (but not by spectral searching).
When you create a library, you determine the kinds of information
that will be saved with it.
?
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In OMNIC Help Topics find “library” in the Index and go to
“Creating a user library.”

How can I display a library spectrum in a spectral window?
Locate and select the spectrum in Library Manager and then click the
Add To Window button, or go to the Library Spectra tab of Library
Manager, display the desired spectrum on the tab and then doubleclick the spectrum.
?

In OMNIC Help Topics find “library” in the Index and go to
“Working with libraries.”

How can I find a compound in a commercial library?
Library Manager in the Analyze menu lets you search for the
compound name. After you select the library on the Library Names
tab, use the features on the Search For Text tab to locate the
spectrum. Type the text to search for in the Text In Selected Item
box, and then choose Search. The search results appear in the table
based on the options you have set. To see information about a found
spectrum, double-click its row in the table.
?

In OMNIC Help Topics find “library” in the Index and go to
“Searching a library for text.”
You can use the extended search feature (available on the Extended
Search tab of the Library Setup dialog box) to find library spectra by
searching for text in any field included in the library. For example,
some libraries have fields for molecular weight, boiling point or
manufacturer.

?

In OMNIC Help Topics find “extended search” in the Index and go
to “Using extended search.”
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What is the easiest way to collect sample spectra and add them to
a spectral library?
Use the Collect Spectrum button on the Library Names tab of
Library Manager to collect a spectrum and add it to a user library.
The software automatically sets the experiment parameters (for
example, Resolution) so that the spectrum will be compatible with
the selected library. This allows you to collect and add a compatible
spectrum in one step instead of three (using Experiment Setup to set
the parameters, Collect Sample to collect the spectrum and Add To
Library to add the spectrum to the library).
?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Collecting a spectrum and adding it to a user library.”

What does the search expert do?
It determines the spectral regions to search, searches those regions
and then displays the specified number of library spectra that best
match the unknown spectrum, plus comments about the search
results. For example, the search expert may tell you that the best
match is excellent but the second best match is also similar to the
unknown. You will be able to display the list of matches to see their
match values and index numbers.
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Opening, saving
and deleting spectra

?

How do I open a stored spectrum?
Choose Open from the File menu, locate the spectrum or spectra you
want to open, select the filenames of the spectra and then choose
OK. You can hold down the Control key to select multiple files.
In OMNIC Help Topics find “spectrum” in the Index and go to
“Opening spectra.”

How can I save my collected spectra automatically?
Choose Experiment Setup from the Collect menu and turn on Save
Automatically on the Collect tab (Save Automatically is on by
default). Specify a base name for naming the saved spectral data files
in the Base Name box. A sequential number will be appended to the
base name when the spectra are saved. If you want the
interferograms saved with the spectra, turn on Save Interferograms.
Individual spectra are saved with the extension .SPA.
Collecting a Spectrum (available through Learning OMNIC)...
“Preparing the Software”
?

In OMNIC Help Topics find “saving, spectra” in the Index and go to
“File handling.”

Where should I save my spectra?
You have several options for saving spectra; you may choose to use
more than one.
For a permanent record of the spectrum and any other information
you want to record, use a report notebook.
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?

In OMNIC Help Topics find “report notebook” in the Index and go
to “Adding a report to a notebook.”
You can also place spectra in descriptively named user libraries that
you create. Keeping spectra in libraries allows you to find them by
searching for text contained in the information saved with the
spectra.

?

Note

In OMNIC Help Topics find “spectrum” in the Index and go to
“Adding a spectrum to a user library.”
When you add a spectrum to user library whose resolution is lower,
the spectrum is deresolved. For this reason it may be better in some
cases to save your sample spectra as files on the hard disk and
consider the copies of them added to a user library to be for
searching purposes only. ▲
We recommend that you create descriptively named folders
(directories) on your hard disk for different categories of spectra. For
example, you could have a folder for each project you are working
on, for each of your clients, for each laboratory application, or for
each sample type. See your Windows documentation for information
on creating directories. You can specify which folder to use when
you use Save or Save As in the File menu to save spectra. This will
make it easier to find a spectrum in a particular category when you
use Open in the File menu to open a spectrum.

?
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In OMNIC Help Topics find “spectrum” in the Index and go to
“Saving spectra using new filenames.”

How can I save several spectra in one file as a group?
Select the spectra and then choose Save Group from the File menu.
To select more than one spectra, hold down the Control key and
click each spectrum you want to select with the selection tool, and
then release the Control key. Spectral groups are saved with the
extension .SPG.
?

In OMNIC Help Topics find “saving, spectra” in the Index and go to
“Saving a group of spectra.”

How can I delete stored spectra?
Choose Delete Files from the File menu to display the Delete Files
dialog box. Locate and select the spectral data files (with the
extension .SPA, or .SPG for spectral group files) you want to delete
and then choose OK.
?

In OMNIC Help Topics find “spectra” in the Index and go to “How
to delete files.”

Can I delete an entry from a report notebook?
No. OMNIC’s report notebooks are similar to traditional laboratory
notebooks in that information you add to them becomes part of the
permanent record of your work.
You can delete an entire notebook, however, by deleting the entire
notebook file. Choose Delete Files from the File menu to display the
Delete Files dialog box. Locate and select the directory containing
the notebook data files (with the extension .NBK). You will have to
set the List Files Of Type box to All (*.*) to see .NBK files listed.
Select the file you want to delete and then choose OK.

Nexus 870 User’s Guide

113

Printing

How can I specify a printer for printing information?
Use Printer Setup in the File menu. See your Windows
documentation for details on setting the printer parameters.

?

In OMNIC Help Topics find “printer” in the Index and go to
“Setting up the printer.”

How can I create and print reports of my work?
Use the commands in the Report menu. First use Template to select,
edit or create a template for the report. Then use Preview/Print
Report to view the report as it will appear on paper. Click the Print
button to print the report.
View Creating Reports (available through Learning OMNIC) to
learn about OMNIC’s report features.
?

In OMNIC Help Topics find “template” in the Index and go to
“Selecting, editing or creating a report template,” or find “report,
previewing or printing” and go to “Previewing or printing a report.”
You can also use Add To Notebook to add the report to a report
notebook. You can then print the report with the Print button when
you view the notebook using View Notebook.

?
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In OMNIC Help Topics find “report” in the Index and go to “Adding
a report to a notebook.”

How can I preview spectra or other information before printing?
Use Preview/Print Report in the Report menu to view a report as it
would appear on paper. The report is displayed using the current
report template; that is, the template you have specified with
Template or the template you are viewing and working with. If the
report is displayed as you want it to appear on paper, you can print it
by using the Print button.
?

Displaying spectra

In OMNIC Help Topics find “template” in the Index and go to
“Selecting, editing or creating a report template,” or find “report,
previewing or printing” and go to “Previewing or printing a report.”

How can I select more than one spectrum at a time?
After selecting the first spectrum by clicking it, hold down the
Control key while you click each additional spectrum. You can also
choose Select All from the Edit menu to select all the spectra in the
window that are not hidden.

?

In OMNIC Help Topics find “spectra” in the Index and go to
“Selection tool” or “Selecting all the spectra in a spectral window.”

How can I specify colors for displaying spectra?
Choose Options from the Edit menu, click the View tab and then
choose Colors. In the Colors dialog box click the color next to the
spectrum number for which you want to specify the color and then
click the desired color in the color array. To specify the color for
selected spectra, click the color next to Selected Spectrum and then
click a color. Typically red is the color reserved for displaying
selected spectra.
?

In OMNIC Help Topics find “spectra” in the Index and go to
“Specifying colors for spectra and other features.”
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You can also specify colors for displaying spectra in a particular
spectral window. Start by selecting the spectra for which you want to
specify a color, and then choose Display Setup from the View menu.
Click the desired color in the color array and then choose OK. When
the spectra are no longer selected, such as after you select a different
spectrum, they will be displayed in the color you clicked.
?

In OMNIC Help Topics find “spectra” in the Index and go to
“Selecting a color for the currently selected spectra.”

What is the difference between the Display Setup parameters
and the Window options?
The parameters in the Display Setup dialog box affect the currently
active spectral window only. The options in the Window options (in
the Options dialog box) affect all the new spectral windows that you
create. After you create a new spectral window, you can change the
way spectra are displayed in it by using Display Setup.
?

In OMNIC Help Topics find “display parameters” in the Index and
go to “Setting the display parameters,” or find “Window options”
and go to “Window options.”

What can I do with the “Scale” commands in the View menu?
By using the appropriate command, you can display spectra so that
they are easier to see or compare.
Full Scale displays the spectra so that they perfectly fit their panes
vertically. Automatic Full Scale does this automatically when you
change the display with the view finder or selection tool. The Y-axis
displayed corresponds to the selected spectrum.
Common Scale displays all the spectra so that they are not cut off at
the top or bottom and use the same Y scale. This allows you to
compare the band intensities of different spectra.
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Match Scale changes the Y scale of the spectra to be the same as that
of the selected spectrum. (The selected spectrum’s scale is not
changed.) This allows you to compare the band intensities of
different spectra.
Offset Scale shifts the spectra vertically so that they overlap less,
making them easier to see.
When you use these commands, keep in mind that the current Y-axis
is always accurate for the currently selected spectrum but may not
apply to other spectra in the window.
?

In the OMNIC Help Topics Index...
For information on Full Scale or Automatic Full Scale, find
“spectra” and go to “Displaying spectra full scale” or
“Displaying spectra full scale automatically.”
For information on Common Scale, find “spectra” and go to
“Displaying spectra using the same Y-axis.”
For information on Match Scale, find “spectra” and go to
“Matching the Y scale of a spectrum.”
For information on Offset Scale, find “spectra” and go to
“Displaying spectra vertically offset.”

How can I zoom in on an area of a spectrum?
Draw a box around the area using the selection tool and then click
inside the box.
You can also click the top half of the Expand/Contract button at the
left end of the view finder or drag the regions markers in the view
finder to display a smaller spectral region.
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In addition you can use the Roll/Zoom window available in the View
menu (or click the Roll/Zoom Window button in the toolbar if
displayed) to expand an area.
?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Selection tool,” “View finder” or “Rolling and zooming spectra.”

How can I move a spectrum up or down in its pane to see it
better?
Use the selection tool to drag the spectrum up or down.
You can also use the Roll/Zoom window available in the View menu
to move a spectrum up or down.
?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Selection tool” or “Rolling and zooming spectra.”

How can I move a spectrum into another spectral window?
Use the selection tool to drag the spectrum from one spectral
window to another. A copy of the spectrum appears in the second
window, and the original spectrum remains in the first window. You
can also copy or cut the spectrum using Copy or Cut in the Edit
menu and then paste it into another spectral window using Paste.
?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Selection tool,” or find “pasting, spectrum” and go to “Pasting
items.”

How can I move a stacked spectrum into another pane?
Use the selection tool to drag the spectrum from one pane into
another.
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?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Selection tool.”

How can I find the X and Y values of a point in a spectrum?
Use the spectral cursor tool to click the point. The values are
displayed in the readout above the palette.
?

In OMNIC Help Topics find “X and Y values” in the Index and go
to “Spectral cursor tool.”

How can I find the height of a peak?
Use the peak height tool to click the top of the peak. Then drag the
baseline handles to adjust the baseline used for the measurement.
The corrected (measured above the baseline) and uncorrected height
values appear in the readout above the palette.
?

In OMNIC Help Topics find “peak” in the Index and go to “Peak
height tool.”

How can I find the area of a peak?
Use the peak area tool to drag across the peak. Then drag the
baseline handles to adjust the baseline used for the measurement.
The corrected (measured above the baseline) and uncorrected area
values appear in the readout above the palette.
?

In OMNIC Help Topics find “area” in the Index and go to “Peak
area tool.”
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Correcting spectra

Should I correct the baseline of my spectrum?
If a baseline is sloped or curved or significantly above zero
absorbance (or below 100% transmittance), a likely cause is how the
sample was prepared. By correcting the baseline, you can often
avoid having to prepare the sample again and collect a new
spectrum.
Correcting a baseline will give you better results when you search
the spectrum against a library, subtract the spectrum from another
spectrum, find peaks in the spectrum or quantify components in the
spectrum.
Collecting a Spectrum (available through Learning OMNIC)...
“Common Problems with IR Spectra”

?

120

Nicolet

In OMNIC Help Topics find “baseline” in the Index and go to
“Correcting a baseline manually.”

Subtracting,
adding, multiplying
and dividing spectra

How can I subtract a spectrum from another spectrum?
Use Subtract in the Process menu whenever you want to subtract one
spectrum from another. Subtract is commonly used to remove
spectral features of solvent residues or pure components from the
spectrum of a mixture of compounds.
Select the spectrum from which you want to subtract spectral
features; this is the sample spectrum. Then hold down the Control
key and select the spectrum with the features you want to subtract
from the sample spectrum; this is the reference spectrum.

Note

Subtract is available only when two spectra are selected. ▲
Choose Subtract from the Process menu. The difference spectrum is
displayed full scale in the bottom pane. This spectrum is the result of
subtracting the reference spectrum from the sample spectrum using
the subtraction factor shown to the left of the result. If you are not
satisfied with the subtraction result, you can change the subtraction
factor.

?

In OMNIC Help Topics find “spectrum” in the Index and go to
“Subtracting spectra.”

What should I use subtraction for?
Subtract is commonly used to remove spectral features of solvent
residues or pure components from the spectrum of a mixture of
compounds. When you use Subtract, the software calculates data
point by data point the difference between the two.
Spectral subtraction is useful in a variety of situations. Here are some
examples:

• Eliminating solvent peaks in a spectrum of a sample that is
dissolved in a solvent.
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• Separating components from a sample that is a mixture of two or
more components.

• Identifying an unknown contaminant by subtracting out the
known sample material.

• Ensuring quality by subtracting an original batch sample
spectrum from a spectrum from the next batch.

What other mathematical operations can I perform on my
spectra?
You can manipulate spectra using any of the common math operations.
Use Spectral Math in the Process menu to perform these operations on
one or two selected spectra. You specify the operations to perform by
typing a sequence of mathematical symbols and numbers. The
software performs the operations on the Y values of the data points in
the spectrum or spectra and then displays the result spectrum.
When you choose the command, the Spectral Math window appears
allowing you to type the desired operations in the Operation text box.
You can also select one of the example operations provided in the
Operation drop-down list box.
View Using Spectral Math (available through Learning OMNIC).

?
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In OMNIC Help Topics find “spectrum” in the Index and go to
“Performing arithmetic operations on spectra.”

Customizing OMNIC

How can I customize my OMNIC software?
You can use Options in the Edit menu to set options that determine
how the software operates. You can also customize the menus and
the toolbar using Edit Menu and Edit Toolbar in the Edit menu. Use
Save Configuration As in the File menu to save your customized
settings in a configuration file. You can then open the file later to
reset OMNIC to your preferences in one step.
Collecting a Spectrum (available through Learning OMNIC)...
“Preparing the Software”

?

In the OMNIC Help Topics Index...
Find “options” and go to “Customizing OMNIC by setting
options.”
Find “menu” and go to “Customizing a menu.”
Find “toolbar” and go to “Customizing a toolbar.”
Find “configuration” and go to “Saving a configuration.”
Find “configuration” and go to “Opening a configuration.”
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Other questions

How can I find and label peaks in spectra?
Use Find Peaks in the Analyze menu to find and label peaks above a
specified threshold.
You can also use the annotation tool to label individual peaks.

?

In OMNIC Help Topics find “peaks” in the Index and go to “Finding
peaks above a specified height,” or find “label” and go to
“Annotation tool.”

How can I close a task window (such as the Find Peaks window)?
Click the Close button (if available) in the upper-right corner of the
window. You can also double-click the button at the left end of the
window’s title bar (if the window is not maximized) or the button at
the left end of the menu bar (if the window is maximized).
?

In OMNIC Help Topics find “task window” in the Index and go to
“Task windows.”

How can I select a spectral region for an operation?
Use the region tool to drag across the region in the pane.

?
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In OMNIC Help Topics find “spectral region” in the Index and go to
“Region tool.”

How can I display information about how a spectrum was
collected and processed?
Select the spectrum and then click the Information button to the left
of the title box. You can also double-click the spectrum’s title in the
title box.
?

In OMNIC Help Topics find “collection and processing information”
in the Index and go to “Collection and processing information.”
If you want this kind of information displayed in a spectrum’s pane,
choose Display Setup from the View menu, turn on Sampling
Information and then specify the types of information you want
displayed by turning on options in the Sampling Information box.

?

In OMNIC Help Topics find “displaying, sampling information” in
the Index and go to “Displaying sampling information.”

How can I copy a spectrum and paste it into a text document?
Select the spectrum and choose Copy from the Edit menu. This
places the spectrum on the Clipboard in the form of a Windows
metafile (this is the file format with the most flexibility for pasting
into other programs). You can then paste the spectrum into a
document by using a word processing program.
?

In OMNIC Help Topics find “copying, spectrum” in the Index and
go to “Copying items.”

Nexus 870 User’s Guide

125

How can I get on-line Help while using the software?
The OMNIC on-line Help system lets you quickly find answers to
your questions about using the software. There are several ways to
enter the Help system:

• To see information about a particular feature in OMNIC, click
the feature using the right mouse button. A brief description of
the feature appears, and in most cases one or more buttons that
you can click to display more detailed information. Click the
Discussion button to display a complete discussion of the feature
(or the dialog box or window that contains the feature). Click the
How To button to display a step-by-step procedure for using the
feature (or the dialog box or window that contains the feature).

• You can press the F1 function key at any time to see a discussion
topic for the currently displayed or selected feature, dialog box or
window.

• If a dialog box or window contains a Help button, click it to see
information about the dialog box or window (or the command
that displayed it).

• To see the Contents of the OMNIC Help system, choose OMNIC
Help Topics from the Help menu.
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Quick Answers to Your Questions About
Using the Spectrometer
This chapter answers some common questions about using your
spectrometer. Each answer is followed by a reference telling you
where to go for more information.

Do I need to use an energy screen with my detector?
If you are using a highly sensitive detector such as a PbSe,
Si, MCT-A or InSb detector and your experiment deals with
information from a broad range of frequencies, use an energy screen
to prevent the detector from becoming saturated or producing a
distorted signal.
Spectrometer Help Topics...
“Installing an energy screen” in “Setting up experiments”

When do I need to open the spectrometer cover?
You need to open the spectrometer cover to change sources. Also,
you need to open the cover if you are installing a spectrometer
component such as a laser.
Spectrometer Help Topics...
“Opening the main cover” in “Installing optional hardware”
Warning

Do not operate the spectrometer with the main cover open. The cover
protects you from exposure to laser light and live electrical
connections. If you must open the main cover for maintenance or
service reasons, always turn the spectrometer power off first. ▲
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When should I align the spectrometer?
Align the spectrometer after you install a new beamsplitter, replace
the laser or move the spectrometer. It is also a good idea to align the
spectrometer if the signal intensity has dropped significantly from its
usual level. For best performance align the spectrometer at least once
a week (once a day if you are performing step scan or other advanced
experiments).
?

In OMNIC Help Topics find “aligning, spectrometer” in the Index
and go to “Aligning the spectrometer.”

Does my detector need to be cooled with liquid nitrogen?
Detectors that have a dewar need to be cooled. Dewar detectors are
fairly large metal cylinders with a hole in the top. These include
MCT and InSb detectors. To determine if your detector requires
cooling, open the detector compartment cover and see if the detector
has a dewar.
If during a work session you find that the signal intensity from your
cooled detector is decreasing, it may need to be refilled with liquid
nitrogen.
Spectrometer Help Topics...
“Cooling a detector” in “Setting up experiments”

When should I change the desiccant (in sealed and desiccated
spectrometers only)?
If your spectrometer is in use, check the performance of the
desiccant by using the Check Desiccant button on the Diagnostic tab
of the Experiment Setup dialog box. If the check indicates that the
desiccant is no longer effective, replace it.
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Spectrometer Help Topics...
“Checking and changing desiccant” in “Maintaining your
spectrometer”
If your spectrometer is in storage, check the round, blue indicator on
the desiccant holder under the beamsplitter compartment cover
monthly. Change the desiccant if the indicator has turned pink.
See the replacement parts lists in “Ordering Parts” in Spectrometer
Help Topics to find the part number for desiccant bags. The
desiccant holder under the beamsplitter compartment cover holds
one bag.

Which source should I use?
Use the source that is appropriate for the spectral range of your
experiment (determined by the ranges of the beamsplitter and
detector). Nicolet offers a mid-IR to far-IR source (Ever-Glo) and a
near-IR source (white light).
?

In OMNIC Help Topics find “source” in the Index and go to
“Specifying the source type.”
“Spectrometer Basics” chapter...
“Selecting the right beamsplitter and detector” in “Using
beamsplitters and detectors”

Should I turn off the spectrometer when I’m not using it?
We recommend that you leave the spectrometer on. This improves
the thermal stability of the system and gives you more consistent
results when you collect spectra.
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How can I diagnose problems with the spectrometer?
The performance of the spectrometer is monitored while you collect
spectra. If a problem occurs, a troubleshooting message appears.
See the “Troubleshooting” book in Spectrometer Help Topics for
instructions on diagnosing spectrometer problems and ordering and
replacing parts.
Note

If you want to view the on-line videos to help you in troubleshooting
a problem, put the Spectrometers Tutorials CD in the computer. ▲
You can also make a more thorough check on a spectrometer
component by choosing Advanced Diagnostics from the Collect
menu. This starts the Bench Diagnostics program, which provides
information on the status of the component as well as
troubleshooting information, replacement procedures and
information on ordering replacement parts.
“Diagnostics” chapter

?

In OMNIC Help Topics find “diagnostics” in the Index and go to
“Checking bench components.”

How do I replace parts in the spectrometer?
Spectrometer Help Topics...
“Replacing parts”
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Maintenance and Service
This chapter describes maintenance and service routines that you can
perform on the spectrometer. We define maintenance as an
occasional procedure you perform to keep the spectrometer running
efficiently. We define service as a procedure to replace a failing part
in the spectrometer.
Warning

Perform only those procedures described in this chapter. If there are
other problems, contact Nicolet at one of the numbers below.
Outside the U.S.A. call your local sales or service representative.
Telephone numbers for all Nicolet Customer Support offices are
provided with your system.

•
•
•
•

Telephone (U.S.A.):
Fax:
World Wide Web:
E-mail:

1-800-NICOLET (1-800-642-6538)
1-608-273-5045
http://www.nicolet.com
nicinfo@nicolet.com ▲

See the “Troubleshooting” book in Spectrometer Help Topics for
instructions on diagnosing spectrometer problems and ordering and
replacing parts.
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Aligning the
spectrometer
and accessories

This section describes how to use the OMNIC software to align the
spectrometer and accessories.

Aligning the spectrometer

To ensure optimum system performance (high signal intensity, low
noise and good sensitivity), you should occasionally align the
spectrometer using the OMNIC software.

Note

View “Maintaining your spectrometer” in Spectrometer Help Topics
for instructions for other common maintenance procedures, such as
changing desiccant, cleaning the purge filter and cleaning the outside
of the spectrometer.

If you have just turned on or moved the spectrometer, wait
15 minutes (one hour for best results) before you align it so that it
will have time to stabilize. ▲
Follow these steps:
1. Remove any sample or accessory from the sample
compartment.
The beam path must be clear during alignment. Open the sample
compartment as briefly as possible to maintain a constant purge.

2. Choose Experiment Setup from the Collect menu.
The Experiment Setup dialog box appears.

3. Make sure Sample Compartment on the Bench tab is set to
Main.

4. Set Gain on the Bench tab to 1.
Do not use Autogain.
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An interferogram is shown in the live display. If you want to
view a single-beam spectrum instead, turn on the Single Beam
check box below the live display.
If you want to hear a tone whose pitch indicates the signal
intensity, turn on the Tone check box below the live display. The
tone reaches its highest pitch when the signal is maximized.

5. To perform an alignment, click the Align button on the
Diagnostic tab.
When you click the Align button, the system begins to optimize
the detector signal for maximum energy throughput. Alignment
should take 2 to 4 minutes.
The live display of the detector signal changes as each
interferogram is collected. The positive peak and negative peak
intensities are shown next to Max and Min above the live
display. The interferogram location will be shown next to
Location, unless you turned on Single Beam.

6. When the alignment is finished, close the Experiment Setup
dialog box.

Aligning an accessory

You can also align accessories that mount inside a sample
compartment. First align the spectrometer without the accessory
installed, as described above. Then set Sample Compartment on the
Bench tab of the Experiment Setup dialog box according to the
accessory location. Set Gain to a value that gives a signal intensity
that is appropriate for the accessory. ATR and diffuse reflection
accessories typically use a Gain setting of 2 or 4.
If you are not satisfied with the signal intensity after alignment, you
can manually align most accessories to maximize the signal. For
complete instructions, see the manual that came with the accessory.
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When you manually adjust an accessory, watch the largest
interferogram peak. The larger this peak, the better is the signal
intensity.
Note

The largest interferogram peak can be positive or negative. ▲
If you are unable to see the display, turn on Tone before adjusting
the accessory. The tone reaches its highest pitch when the signal is
maximized.
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Servicing your
spectrometer

Three spectrometer components—the light source, the laser module
and the main power supply—were designed so you can replace them
yourself if they fail.

Note

The diagnostics software will alert you to failing components. For
instructions on diagnosing spectrometer problems, ordering parts and
replacing parts, choose Spectrometer Help Topics from the Help
menu. ▲
If the source, laser module or power supply must be replaced, refer
to the replacement parts list made available when you choose
Spectrometer Help Topics from the Help menu. Call 1-800NICOLET (1-800-642-6538) or 1-608-276-6373 to order the
replacement assembly. If you are outside the U.S.A., contact your
local Nicolet office. Telephone numbers for all Nicolet Customer
Support offices are provided with your system.
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Diagnostics
This chapter explains how to use diagnostic software features to find
and correct problems that occur when you use the system. We will
cover...

•
•
•
•

Checking
the performance
of spectrometer
components
Note

Checking the performance of spectrometer components.
Running the spectrometer performance test.
Performing advanced diagnostic tests.
Using remote diagnostics.

If your system is not performing properly, you can use the
Diagnostic tab in the Experiment Setup dialog box to check the
performance of spectrometer components and determine the source
of the problem.

OMNIC continuously monitors the operation of the spectrometer
hardware and shows its status with the Bench Status indicator below
the menu bar of the OMNIC window. See “The OMNIC window” in
the “Your First Experiment” chapter for more information. ▲
Follow these steps to run the spectrometer diagnostic tests:
1. Make sure the main sample compartment is empty.
Remove any samples and sampling accessories.

2. Choose Experiment Setup from the Collect menu.
The Experiment Setup dialog box appears.
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3. Click the Diagnostic tab.
The Diagnostic tab appears showing icons for the major
components of the spectrometer with a live display of the signal
from the detector.

4. To run the diagnostic tests for a component, click that
component’s indicator icon.
A dialog box appears showing the status of the component. If the
operating values for the component are within proper limits, a
check mark appears in the Status column. If the value is outside
the acceptable range, an X appears in the Status column.
When you are finished viewing the information, choose OK.
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Running the
spectrometer
performance test

You can use the performance test to track long-term spectrometer
performance. Run it after you have installed the system and then
weekly. Keep a record of the actual values obtained. When you run
the test, the software measures the response of the spectrometer
optics and atmospheric absorptions in the spectrometer and then
collects a “sample” spectrum with no sample in place. The result is a
“100% line,” a display of system noise that appears as a generally
flat line at 100% transmittance.
Follow these steps:
1. Make sure the main sample compartment is empty.
Remove any samples and sampling accessories.

2. Exit OMNIC.
This ensures that the diagnostics software will run correctly.

3. Start the diagnostics software.
To do this, click the Start button in Windows, point to Programs,
point to the OMNIC E.S.P. folder and then choose Bench
Diagnostics.
See “Performing advanced diagnostic tests” for more
information on running the diagnostics software.
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4. Click the Performance Tests button and follow the
instructions that appear on the screen.
Note

If the noise readings are greater than normal or have changed
significantly, call the Nicolet Customer Support Department for
assistance. Outside the U.S.A., call your local service representative.
Telephone numbers for all Nicolet Customer Support offices are
provided with your system. ▲
If special performance tests are available for your spectrometer, a
button labeled “Extended Tests” (or another appropriate name)
will appear. Click this button and follow the instructions that
appear on the screen to perform the tests.
See “Running the remote diagnostics” for information about
running performance tests for AM and PM step-scan
experiments, PEM experiments, rapid scan, and the expanded
spectral range available with your spectrometer
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Performing advanced
diagnostic tests

The diagnostics software provided with your system lets you
perform advanced diagnostic tests on the main components of the
spectrometer. You should run these tests if you have problems with
your spectrometer to determine the source of the problem. The
diagnostics provide information on the status of the component as
well as troubleshooting information, replacement procedures and
information on ordering replacement parts.
Use the diagnostics software to:

•
•
•
•
•

Run the spectrometer performance test.
Test specific components of your spectrometer.
Get information about replacement parts.
Check the spectrometer configuration.
Get troubleshooting tips.

Follow these steps to run the diagnostics:
1. Make sure the main sample compartment is empty.
Remove any samples and sampling accessories.

2. Start the diagnostics software.
To do this, choose Advanced Diagnostics from the Collect menu.
You can also click the Start button in Windows, point to
Programs, point to the OMNIC E.S.P. folder and then choose
Bench Diagnostics. Some of the advanced features of the
software, including the performance test, are not available if you
run the diagnostics from OMNIC.
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3. Follow the directions that appear on the screen to run the
diagnostic tests.
When you are finished viewing information in a window, you
can use the navigation buttons to return to earlier windows. Click
this button to return to the previous window.

Click this button to return to the main Diagnostics window.

Exit the diagnostics software by clicking the Close button at the
far right end of the title bar.
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Using remote
diagnostics
Note

Remote
diagnostic sessions

The Nexus 870 is equipped with remote diagnostic capabilities. This
includes a data modem and remote control software that allows
control of your computer (and spectrometer) through the modem
link. To take advantage of the remote diagnostic capabilities, you
must have the modem connected to an analog telephone line.
We recommend that you dedicate a separate telephone line for data
modem calls. If you require assistance, Nicolet Customer Support
can discuss the problem with you through the voice line while
running diagnostic tests on your system through the modem line. ▲

Follow these steps to start a remote diagnostic session:
1. Contact Nicolet and schedule a remote link.
Remote links are provided only within the system warranty
period or with an RSVP contract.

Note

Steps 2, 3 and 4 must be completed before the scheduled remote link.
The diagnostic session cannot begin until then. ▲

2. Exit the OMNIC software and close any open applications.

3. Start the remote control software.
Choose Start, point to Programs and then choose Carbon Copy 32
in the Carbon Copy folder.
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4. Click the Wait For Call button.
You can also choose Wait For Call from the Connections menu.

5. Watch the screen while the remote session starts.
If you see any error messages, contact Nicolet Customer Support
by telephone for assistance.
Note

Modem line
specifications

Once the remote session starts, do not use your computer unless the
service engineer asks you to. When the service engineer is finished,
the computer is returned to normal operating mode. ▲

The data modem requires an analog phone line (an outside line in
most businesses). Many private branch exchange (PBX) phone
systems use digital phone lines that will not work with your data
modem. Ask your PBX administrator for a direct outside line or a
sampled analog trunk line.
Use the following guidelines to determine whether or not you have
an analog phone line.
Rotary phone – All rotary phones are analog phones. If you hear a
dial tone when you plug a rotary phone into the phone wall jack, you
have an analog phone line and your data modem will work.
Push-button phone – If you have a push-button phone, check the
bottom of the phone to see whether it has a ringer equivalence
number (REN) or a load number (LN). All analog phones have an
REN or an LN. If you hear a dial tone when you plug a push-button
phone that has an REN or an LN into the wall jack, you have an
analog phone line and your data modem will work.
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Wall jack specifications

Running the
remote diagnostics
Note

In the U.S.A., install an RJ-11 jack; in Canada, install a CA11A
jack. For other locations, contact your local Nicolet office for jack
requirements.

The Bench Diagnostics program includes performance tests for AM
and PM step-scan experiments, PEM experiments, rapid scan, SMM
and the expanded spectral range available with your spectrometer.
If you plan to test the visible capabilities, make sure the quartz
beamsplitter, silicon detector and appropriate energy screen or
optical filter are installed in your spectrometer and selected (using
Experiment Setup) before you start the Bench Diagnostics. ▲
Follow these steps to test these capabilities:
1. Remove any samples or accessories from the sample
compartment.

2. Use Experiment Setup in the Collect menu to select the
beamsplitter you need for your tests.
If you are planning to run one of the visible tests, select the
quartz beamsplitter.

3. Exit OMNIC.

4. Start the Bench Diagnostics.
Choose Start, point to Programs and then choose Bench
Diagnostics in the OMNIC E.S.P. folder.
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5. Choose Performance Test.

6. Choose Advanced Tests.

7. Click the button labeled with the name of the test you wish to
run.
Note

Some tests are available only when the optional software is installed
on your computer. ▲

About the individual tests

The Bench Diagnostics program includes performance tests for AM
and PM step-scan experiments, PEM experiments, rapid scan, SMM
and the expanded spectral range available with your spectrometer.

Rapid scan

When you choose Rapid Scan, the diagnostic checks the number of
scans per second at the highest linear scan velocity for your
spectrometer. The results are reported as number of scans per second
and indicate whether the bench passed or failed the test.

Visible

Two visible spectral range tests are available. You must install and
select visible-light hardware before you use this test.
1. Install a quartz beamsplitter, silicon detector and blue filter.
Use the broad-band blue filter when testing the 23,000 to
16,000 cm-1 capabilities.

146

Nicolet

Use the narrow-band blue filter when testing the 25,000 to
23,000 cm-1 capabilities.
See “Installing optional hardware” in Spectrometer Help Topics
for complete instructions for installing detectors, beamsplitters
and filters.

2. Use OMNIC to select the visible light hardware.

AM step scan

This test checks the amplitude modulation step-scan circuitry. You
must install a cable and an energy screen before using this test.
1. Install the BNC-to-BNC cable.
Connect the cable between the Detector A and Internal Detector
connectors on top of the spectrometer.
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2. Install energy screen B in the sample compartment.
In Spectrometer Help Topics view “Installing an energy screen”
in the “Setting up experiments” book for instructions on
installing energy screens.
You do not need to set any AM setup parameters before running this
test. Your parameters will be restored when the test is completed.

PEM

This test checks the dual-channel circuitry. You must install cables
before using this test.
1. Install the BNC “T” connector.
Connect it to the Detector A connector on top of the spectrometer
as shown in the illustration in the next step.
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2. Install the BNC-to-BNC cables.
Connect one cable between the BNC “T” connector and the
Detector B connector on top of the spectrometer. Connect the
other cable between the BNC “T” connector and the Internal
Detector connector.

You do not need to set any PEM setup parameters before running
this test. You may need to reset the parameters before running your
next PEM experiment.

PM step scan

This test checks the phase modulation step-scan circuitry in the
spectrometer and reports the signal-to-noise ratio.
No cable connections are required, and you do not need to set any
PM setup parameters before running this test. Your parameters will
be restored when the test is completed.
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SMM

This test is a simulation of an SMM (synchronous multiple
modulation) experiment. It verifies the basic operation of the
spectrometer electronics.
This test requires cable connections.
Install the BNC-to-BNC cables.
Use one cable to connect the Internal Detector connector to the
Detector B connector on top of the spectrometer. Use another cable
to connect the Sync connector to the Laser connector on top of the
spectrometer.

TRS
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This test checks the time-resolved step-scan circuitry in the optical
bench and is available only if your system is equipped with the
optional OMNIC SST with TRS Experiments software.

You do not need to set any TRS setup parameters before running this
test. Your parameters will be restored when the test is completed.
The results will be reported as the signal-to-noise ratio and will
indicate whether the spectrometer passed or failed.
You must install cables before selecting this test. You may also need
a data acquisition card installed in your computer.
1. Install the BNC “T” connector.
Connect it to the Detector A connector on top of the spectrometer
as shown in the illustration in the next step.

2. Install the BNC-to-BNC cables.
Connect one cable between the BNC “T” connector and the
Internal Detector connector on top of the spectrometer.
Connect a second cable between the BNC “T” connector and the
channel 1 input on the data acquisition card (or the Detector B
connector on top of the spectrometer, for internal TRS data
collection).
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Connect a third cable between the Trigger connector on top of
the spectrometer to the trigger input (EXT) on the data
acquisition card.

To trigger input

Note

▲ Caution
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Choose Yes when prompted for information about the background
source. ▲
If you are not planning to run a TRS experiment, disconnect the data
acquisition card cables from the spectrometer when you finish
running the TRS tests. Never leave the spectrometer connected to the
data acquisition card when you are not running TRS experiments or
tests. It could affect your data. ▲

Troubleshooting Software Problems
The OMNIC software automatically and continuously checks the
status of your system. If a problem is found, a message automatically
appears giving you access to more information. This chapter lists
some simple troubleshooting measures you can take to solve
software problems with OMNIC. If the action does not solve the
problem, call your Nicolet service office.
?

In OMNIC Help Topics find “troubleshooting” in the Index and go
to “Troubleshooting” for more information.

Problem

Possible Cause

Solution

After data collection,
message says sample
and background
spectra have wrong
resolution.

Resolution of current
background spectrum does not
match resolution selected for
sample spectrum collection.

Change Resolution to match background
and collect spectrum again. Use Resolution
parameter on Collect tab of Experiment
Setup dialog box.

Quantify command is
dimmed.

No quantitative analysis
method is selected.

Select quantitative analysis method using
Quant Setup in Analyze menu.

No spectrum is selected.

Select single spectrum.

Quantitative analysis method is Select appropriate method for selected
not appropriate for selected
spectrum.
spectrum.
You cannot add
spectrum to user
library.

Resolution of spectrum is
lower (higher numerical value)
than that of library.

Collect spectrum at same resolution as
library (first set Resolution on Bench tab of
Experiment Setup dialog box), and then add
it to library.
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Problem

Possible Cause

Solution

OMNIC needs to be
restored after system
crash, or message
states that OMNIC
cannot start or will no
longer run.

There is not enough memory.

Make sure OMNIC has enough memory.
Quit other programs to free memory for
OMNIC.

There is another system
problem.

Restart Windows.
Run SCANDISK utility included with your
Windows software.
Restart OMNIC. If OMNIC does not start,
reinstall it.

Experiment provided
with OMNIC does not
produce good results.

Parameter settings in
experiment file have been
changed so that experiment is
no longer useful.

Restore experiment to its default settings:
First open experiment using Experiment
Setup and save it using new filename if you
do not want to overwrite it. Then open
experiment in FACTORY directory whose
filename is same as original experiment and
save it in OMNIC\PARAM directory.

Desired experiment
Experiment was installed with
does not appear in
software but has not yet been
Experiment drop-down opened.
list box.

If experiment was designed for Smart
accessory, install accessory; experiment will
be opened automatically and will appear in
Experiment drop-down list box. If
experiment was not designed for Smart
accessory, open it using Experiment Setup;
it will be added to list.

Libraries created with
previous version of
OMNIC are not listed
in Library Setup dialog
box.

Use Add Directory button on Search
Libraries tab to add directory.
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Libraries are not in one of
directories listed in dialog box
(typically LIBS within
OMNIC directory).

Troubleshooting Hardware Problems
OMNIC continuously monitors the operation and status of your
spectrometer and informs you if a problem is found. The Bench
Status indicator below the menu bar shows the status of the
spectrometer operation. When OMNIC performs a check and detects
a problem, the Bench Status indicator is displayed as a yellow circle
or a red X along with an message alerting you to the problem.
If the indicator is a yellow circle, a cooled detector in the Nexus 870
has become warm A message appears explaining the problem and
allowing you to access information on correcting it.
If the indicator is a red X, the spectrometer has failed a diagnostic
test and requires corrective action. A message appears explaining the
problem and allowing you to access information on correcting it.
This chapter lists some simple troubleshooting measures you can
take to solve problems with the spectrometer. The diagnostics
software is described in the “Diagnostics” chapter. If your actions do
not solve the problem, call your Nicolet service office.
For more troubleshooting information see the “Troubleshooting”
book in Spectrometer Help Topics.
Warning

Always follow the safety precautions included in this manual and in
your Spectrometer Safety Guide when performing any of the
following troubleshooting procedures. ▲
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Problem

Possible Cause

Solution

Status indicators do not
light when spectrometer
is turned on.

Spectrometer is not plugged in.

Make sure power cord is plugged
into spectrometer and working wall
outlet.
Check power LEDs on rear panel.
All LEDs light when power supply
is working properly.

Power cable or power supply is
defective.

Call Nicolet to order replacement
part.

Laser is not functioning.

Hold business card or other small
piece of white paper in beam path in
sample compartment to check for
laser light. Replace laser if
necessary.

Data cable between
spectrometer and computer is
not properly connected.

Turn spectrometer power off and
check data cable connections.

Source status indicator
is off.

Source is burned out.

Call Nicolet to order replacement
source. In Spectrometer Help Topics
view “Replacing your source” in
“Replacing parts” to find part
number, ordering and installation
instructions.

System does not scan.

Laser is flickering.

Hold business card or other small
piece of white paper in beam path in
sample compartment to see if laser
light flickers. If it does, call Nicolet
for service.

Data are not displayed
during collection.
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Problem

Possible Cause

Solution

There is frost on outside
of detector.

Insulating vacuum chamber
surrounding dewar has begun to
leak.

If you suspect your detector has
vacuum leak, view “Detector does
not stay cooled” in
“Troubleshooting” in Spectrometer
Help Topics.

Signal intensity is low,
there are frequent
modulator scan restarts
(verified by intermittent
flashing of Scan
indicator) and
spectrometer alignment
fails.

Beamsplitter is fogged.

Check laser signals by clicking laser
indicator on Diagnostic tab in
Experiment Setup dialog box. If you
suspect beamsplitter is fogged, call
Nicolet for service.

Baseline is not stable.

Purge rate is too high.

Lower purge rate until baseline is
stable.

Center laser detector is
misaligned.

Use diagnostics software to check
laser levels for proper balance. If
levels are out of tolerance, align
spectrometer using Align button on
Diagnostic tab in Experiment Setup
dialog box. If levels remain out of
tolerance, call Nicolet for service.

Desiccant is expired.

Replace desiccant.

Spectrometer cover was
recently opened.

Allow spectrometer to purge for 3 to
5 minutes after cover is closed.

Signal intensity is low in Source is glowing unevenly.
mid-IR range.

Check to see if source element is
glowing evenly. Order replacement
source if needed.
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Problem

Possible Cause

Solution

System scans but gives
very low signal
intensity.

Spectrometer is out of
alignment.

Align spectrometer using Align
button on Diagnostic tab in
Experiment Setup dialog box.

Detector and beamsplitter are
not compatible.

Make sure that selected detector and
beamsplitter are compatible. Change
detector or beamsplitter if necessary.

There is no interferogram.

If Source status indicator is off, click
source indicator on Diagnostic tab in
Experiment Setup dialog box to
check source current and voltage. If
Source indicator is on, check
interferogram on Bench tab in
Experiment Setup dialog box; if
interferogram is not present, check
beam path and detector.

Custom detector is selected on
Bench tab of Experiment Setup
dialog box.

Set Detector to None on Bench tab
of Experiment Setup dialog box.

Detector cable is loose at
accessory connector (on rear of
spectrometer or on back wall of
sample compartment).

Check and tighten cables.

Beamsplitter is fogged.

Check laser signals by clicking laser
indicator on Diagnostic tab in
Experiment Setup dialog box,
remove beamsplitter and check
beamsplitter center window for
fogging (check clear area located in
center of substrate). Replace
beamsplitter if necessary.

You encounter problems
when selecting external
detectors on AEM, GC
interface or microscope.

Signal intensity is low,
there are frequent
modulator scan restarts
(verified by intermittent
flashing of Scan
indicator) and
spectrometer alignment
fails.
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Problem

Possible Cause

Solution

Laser status indicator is
off.

Beamsplitter compartment
cover is not fully closed.

Close beamsplitter compartment
cover.

Laser is burned out.

Call Nicolet to order replacement
laser. View “Replacing the laser” in
“Replacing parts” in Spectrometer
Help Topics to find part number and
ordering and installation
instructions.

Spectrometer is out of
alignment.

Align spectrometer using Align
button on Diagnostic tab in
Experiment Setup dialog box.

After 1 hour without data
collection activity,
interferometer stops scanning
and Scan light stays on. This
mode is normal.

No action is required. Any data
collection activity will cause
interferometer to begin scanning.

Beamsplitter is not properly
seated.

Check beamsplitter and reposition it
if necessary.

Beamsplitter compartment
cover is ajar.

Close cover and tighten latch.

Electronic miscue has occurred.

Press Reset button on rear panel.

Component has failed.

Call Nicolet for service.

Scan status indicator
does not flash (system is
not scanning).

Nexus 870 User’s Guide

159

Problem

Possible Cause

Solution

Error message appears
when you try to scan.

Light source is not working.

Check Source status indicator. If
light is out, replace source.

Detector is not cooled.

Check and cool detector.

Interferogram peak is not
located at 1024 ±16 data points
on Bench tab in Experiment
Setup dialog box.

Align spectrometer. If interferogram
is still not located correctly, call
Nicolet for service.

Beam path is blocked.

Hold business card or other small
piece of white paper in beam path in
sample compartment to check for
laser light. If no laser light is visible,
beam path may be blocked. Remove
obstruction.

Data cable between
spectrometer and computer is
not properly connected.

Turn off spectrometer power and
check data cable connections.

Detector and beamsplitter are
not compatible.

Change detector or beamsplitter.
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Troubleshooting Applications Problems
If you have turned on OMNIC’s spectral quality checks feature, the
software automatically checks the status of collected interferograms,
and background and sample spectra. When OMNIC performs a
check and detects a problem with data collection or spectra, the
Collect Status indicator is displayed as a yellow circle or a red X.
You can click the indicator (or click the View Collect Status button
at the end of data collection) to see a summary of data collection
problems encountered during the collection and other information
about the collection.
This chapter lists some simple troubleshooting measures you can
take to solve data collection problems with the spectrometer. If the
action does not solve the problem, call your Nicolet service office.
?

In OMNIC Help Topics find “troubleshooting” in the Index and go
to “Troubleshooting” for more information.

Problem

Possible Cause

Solution

Spectrum contains
derivative-shaped peaks.

Sample in diffuse reflection
experiment also has specular
reflection component.

Correct spectrum by using Other
Corrections in Process menu. (Select
Kramers-Kronig.)

Infrared beam was reflected
from (instead of penetrating)
flat, shiny sample measured
using specular reflection
accessory.

Try using less reflective sample.
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Problem

Possible Cause

Solution

Spectrum contains totally
absorbing peaks.

Sample in transmission
experiment is too thick.

Use thinner sample.

Spectrum contains
carbon dioxide peaks.

Spectrometer is not adequately Make sure you are using correct purge
purged.
gas and that purge flow rate is
adequate. Allow system three to five
minutes to reestablish purge before
collecting spectrum.

There are no peaks in
spectrum.

There is no sample in infrared
beam path.

Check sample compartment or
accessory to make sure sample is
properly positioned in beam path.

Sampling cup in diffuse
reflection experiment is not in
place or is tilted.

Make sure cup is properly positioned
in diffuse reflection accessory.

Infrared microscope is in its
viewing mode.

Put microscope in infrared mode and
collect spectrum again.

Sample film in attenuated total Make sure sample is held evenly and
reflection (ATR) experiment is has good contact with crystal.
being held against ATR crystal
with uneven pressure or has
poor contact with crystal.
Spectrum contains water
peaks.

Spectrometer is not adequately Make sure you are using correct purge
purged.
gas and that purge flow rate is
adequate. Allow system 3 to 5 minutes
to reestablish purge before collecting
spectrum.
Desiccant is expired.
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Check desiccant and replace it if
needed.

Problem

Possible Cause

Solution

Spectrum contains
fringes or channeling.

Sample has parallel, highly
reflective sides that cause
infrared beam to bounce
within sample when it is
placed perpendicular to beam.

Create new film using matte press.
Try roughening film surface slightly
with silicon carbide paper or other
suitable abrasive.
Rotate sample so that infrared beam
passes through sample at Brewster’s
angle. (Do not use this method if you
are performing quantitative analysis of
sample.)

Baseline of spectrum is
not flat.

KBr pellet was made with
coarsely ground KBr powder,
or KBr pellet was improperly
pressed.

Be sure to press pellet properly.

Background spectrum for cast
film was collected with empty
sample holder in infrared
beam.

Remove sample holder and collect
background again.

Spectrometer is not properly
aligned, causing sloped
baseline.

Use Align button on Diagnostic tab in
Experiment Setup dialog box to align
spectrometer.

Spectrometer has not been on
long enough to reach thermal
equilibrium.

For best results allow spectrometer at
least one hour to stabilize after turning
it on.

Spectrometer is not properly
purged.

Check system to make sure correct
purge gas is being used and that flow
rate is correct.
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Problem

Possible Cause

Solution

Spectrum is too noisy.

Detector is saturated.

Add bandwidth-limiting filters or
energy screens to reduce signal
strength.

There were too few scans.

Increase number of scans on Collect
tab in Experiment Setup dialog box.

Resolution was too high.

Reduce resolution on Collect tab in
Experiment Setup dialog box.
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Index
a

b

absorbance units, 37
accessories, 85, 88
automated sample handling, 88
descriptions, 88
system, 92
when to turn on, 13, 55
accessory
aligning, 133
cabling, 93
detector, 94
installing, 88
power, 94
Advanced Diagnostics, 130, 141
AEM, 89
aligning
accessory, 133
spectrometer, 128, 132
AM step scan, 2, 74
diagnostics, 147
annotation tool, 39, 124
labeling peak using, 40
pointer, 40
aperture
effect on resolution, 65
effect on wavenumber accuracy, 65
for collecting data in visible spectral range, 68
for slow scan, 74
resolution affected by, 67
size for cooled detector, 65
size for detector, 65
ATR accessory, 85, 86, 87
ATR correction, 107
Auxiliary 1 connector, 95
Auxiliary 2 connector, 95
Auxiliary connector, 94
auxiliary experiment module, 89

background spectrum
collected with sample holder in beam, 163
collecting, 30
defined, 22
when to collect, 22
bandwidth-limiting filter, 64
baseline
correcting, 106, 120
not flat, 163
not stable, 157
sloped, 163
baseplate
removing, 88
beam path
blocked, 160
beamsplitter
compatibility with detector, 60
fogged, 157, 158
installing, 128
not compatible with detector, 158, 160
not properly seated, 159
spectral range, 61
types, 59, 60
beamsplitter compartment cover, 159
Bench Diagnostics, 130, 137, 145, 146
starting, 145
Bench Status indicator, 21
blanking totally absorbing bands, 106

c
cable
not properly connected, 158, 160
cabling
accessory, 93
carbon dioxide peaks
removing, 107

Nexus 870 User’s Guide

165

channeling in spectrum, 163
cleaning purge filter, 132
closing window, 124
Collect Sample, 30, 80
Collect Sample window, 103
Collect Status indicator, 34
collecting
background spectrum, 30
sample spectrum, 22, 25
spectrum, 9, 19, 22, 25, 102
color
spectrum, 115
commercial library
finding compound in, 109
common scale, 116
components
separating with subtraction, 122
computer
when to turn on, 14, 56
configuration
default, 25
opening, 25
saving, 123
connector
Auxiliary 1, 95
Auxiliary 2, 95
detector, 94
Detector/Motors, 98
pass-through, 93
connectors
for custom accessories, 96
pinouts, 97
rear panel, 95
sample compartment, 94
contaminants
identifying with subtraction, 122
Continuµm, 89
cooled detector
aperture size for, 65
cooling detector, 15, 128
copying
spectrum, 125
correcting
baseline, 106, 120
spectrum, 106
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custom accessories, 96
Custom baseplate, 89

d
data cable, 156
data collection
parameters, 26
default configuration, 25
default experiment, 25
deleting
report notebook, 113
spectrum, 113
depth of penetration, 107
desiccant
changing, 132
checking, 12
expired, 157, 162
indicator, 12, 129
when to change, 128
detector
accessory, 94
aperture size for, 65
cable, 158
compatibility with beamsplitter, 60
connector, 94
cooling, 15, 128
custom, 158
energy screen, 64, 67, 68, 127, 164
external, 158
frosted, 157
linearity, 63
not compatible with beamsplitter, 158, 160
not cooled, 160
optimizing performance of, 62
photometric accuracy, 63
saturated, 63, 64, 65, 164
signal intensity, 133
silicon, 68
spectral range, 61
types, 59, 60
using filter to reduce energy reaching, 63
detector interface kit, 89
Detector/Motors connector, 98

diagnostics, 137, 141, 143, 145, 146
AM step scan, 147
PEM, 148
PM step scan, 149
rapid scan, 146
SMM, 150
TRS, 150
visible spectral range, 146
diffuse reflection accessory, 85, 87
directory
library, 43, 154
dispersion effects, 107
Display Setup, 116
distortion
in spectrum, 67
documentation, 6

e
energy screen, 64, 67, 164
detectors typically used with, 64
energy passed with, 64
for collecting data in visible spectral range, 68
resolution affected by, 67
when to use, 127
error message
during data collection, 160
Expand/Contract button, 117
experiment
default, 25
not listed, 154
restoring, 154
selecting, 17, 21, 25
Experiment drop-down list box, 17, 21, 25, 101
Experiment Setup, 26
extended search feature, 109
extended spectral range, 69
extension
notebook data file, 113
spectral data file, 113
external beam, 88
external detector, 158
external source, 58

f
F1 function key
for on-line Help, 7
fiber optic accessory, 86
filename
for saving spectrum, 36
filter, 70
bandwidth-limiting, 64
for collecting data in visible spectral range, 68
installing in sample holder, 24
reducing energy reaching detector using, 63
finding peaks, 124
flammable gases, 10
flowmeter, 10
free spectral range, 69
fringes
in spectrum, 163
frost on detector, 157
full scale, 116

g
gain, 103
for collecting data in visible spectral range, 68
gas cells, 89
GC interface, 90
Gemini, 90
Getting Started tutorial, 2

h
hard disk
saving spectra on, 112
hardware requirements, 5
Help, 6, 7, 126
OMNIC, 4
SST, 76

i
Information button, 125
infrared source, 58

Nexus 870 User’s Guide

167

InSb detector
cooling, 128
InspectIR, 89
installing
accessory, 88
beamsplitter, 128
sample, 24, 32
sample holder, 23
interferogram, 133
location, 160
not present, 158
interferograms
saving, 103
saving automatically, 27
interferometer
long-stroke mode, 56, 159

saving spectra in, 112
scrapbook, 108
searching, 106
spectrum cannot be added to, 153
Library Creation Wizard, 49
Library Manager, 49
library search
extended search feature, 109
search expert, 110
specifying spectral regions for, 108
library spectrum
displaying, 109
liquid nitrogen for cooling detectors, 128
live display, 133
log (1/R) units, 105
long-stroke mode, 56

k

m

KBr pellet
improperly pressed, 163
Kramers-Kronig, 161
Kramers-Kronig correction, 107
Kubelka-Munk units, 105

maintenance, 131, 132
manual conventions, 4
matched scale, 117
math operations
performing on spectra, 122
MCT detector
cooling, 128
memory insufficient, 154
menu bar, 20
menu names, 20
microscope in viewing mode, 162
microscopes, 89
mirror velocity, 71
moving
spectrum in pane, 118
spectrum to another window, 118
stacked spectrum, 118

l
label
peak, 40
labeling
peak, 124
laser
burned out, 159
flickering, 156
not working, 156
laser frequency, 69
Laser indicator, 14, 56
library
adding spectrum to, 47, 110
commercial, 109
comparing sample spectrum with spectra in, 42
creating, 7, 49, 108
directory, 43, 154
not listed, 154
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n
near-IR sampling, 86
noise, 64, 66
nonaliased spectral range, 69
number of scans
too low, 164

Nyquist theorem, 69
offset scale, 117

o
OMNIC
customizing, 123
error message, 154
Help, 4, 126
starting, 16
OMNIC window, 20
100% line, 139
Open Configuration, 25
opening
configuration, 25
spectrometer cover, 127
spectrum, 111
optical layout, 52, 53

p
palette, 39
selecting tool in, 39
parameters
setting, 17
pass-through connectors, 93, 96
pinouts, 97
pasting
spectrum, 125
peak
labeling, 40, 124
peak area, 119
peak height, 119
peaks
carbon dioxide, 162
derivative-shaped in spectrum, 161
eliminating with subtraction, 121
finding, 124
noise, 164
none in spectrum, 162
totally absorbing in spectrum, 162
water, 162
PEM, 2, 80
diagnostics, 148

PEM kit, 90
PEM step scan, 80
% reflectance units, 105
% transmittance units, 37
performance test, 139, 141
phase array, 79
calculating, 81
correcting spectrum using, 80
defined, 79
saving, 84
storing, 83
viewing, 83
Phase Array Operations, 80
phase correction
defined, 80
photoacoustic accessory, 90
photoacoustic units, 105
photometric accuracy, 63, 65
pinouts
connector, 97
PM step scan, 2, 74
diagnostics, 149
PM-IRRAS, 90
power
accessory, 94
Power indicator, 14, 56
power line conditioner, 92
power switch, 14
pressure regulator, 10
previewing report, 46, 114
previewing spectrum before printing, 115
printer
specifying, 114
Printer Setup, 114
printing report, 47
pure air generator, 92
purge
flow rate, 10, 11
flow rate too high, 157
gas, 10
inadequate, 162, 163
when to use, 10
purge filter
cleaning, 132
purge gas generator, 92
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q
QC comparison
setting up, 42
QC library, 42
quality standards, 104
Quantify, 153
quantitative analysis, 63, 65, 153

r
rapid scan, 71
diagnostics, 146
Ratio Spectra, 77
ratioing
spectra against common stored background, 77
spectra using SST, 77
two spectra, 78
rear panel, 54
connectors, 95
region
selecting, 124
regions
specifying for library search, 108
remote diagnostics, 143
starting, 143
telephone for, 143, 144
wall jack for, 145
Remote Start accessory, 90
replacing parts in spectrometer, 130
report
creating, 45, 114
previewing, 46, 114
printing, 47
report notebook
deleting, 113
saving spectra in, 111
report template
creating, 46
selecting, 45, 114
requirements of system, 5
resolution, 153
affected by aperture, 65, 67
affected by energy screen, 67
and aperture, 65

170

Nicolet

effect of on signal-to-noise ratio, 66
improving, 67
incorrect, 153
too high, 164
Roll/Zoom window, 118

s
safety, 2
sample
installing, 24, 32
not present, 162
too thick, 162
sample compartment
connectors, 94
sample film
in ATR experiment, 162
sample holder
installing, 23
installing sample or filter in, 24
sample shuttle, 91
sample spacing, 69
sample spectrum
adding to spectral library, 110
adding to spectral window, 35
collecting, 22, 25
entering title for, 30
sample wheel, 88
sampling accessories, 88
sampling cup
missing or tilted, 162
Sampling theorem, 69
saturation, 164
detector, 63, 64, 65
Save, 36
Save As, 36
saving
configuration, 123
interferograms, 27, 103
phase array, 84
spectra, 27, 111
spectra as group, 113
spectra automatically, 111
spectrum, 36

Scan indicator, 14, 56, 157, 158, 159
scans
effect of number of on signal-to-noise ratio, 66
number of, 33
scattering, 66
scrapbook library, 49, 108
sealed and desiccated system, 12, 129
search
specifying spectral regions for, 108
search expert, 110
searching
preparing spectrum for, 106
spectral library, 106
selecting
experiment, 17, 21, 25
report template, 114
spectral region, 124
spectrum, 115
service, 131, 135
signal intensity, 133
low, 158
signal-to-noise ratio, 65, 66
increased by bandwidth-limiting filter, 64
silicon detector, 68
slow scan, 2, 73
filters for, 74
parameters, 74
Smart Accessories, 85
Smart Accessory, 21, 101
Smart baseplate, 23, 89
Smart Purge, 11, 31, 32
Smart Purge Kit, 92
SMM, 2
diagnostics, 150
Snap-In sample compartment baseplates, 23
software
preparing for data collection, 101
requirements, 5
troubleshooting, 153
source, 58
burned out, 156
external, 58
glowing unevenly, 157
not working, 160
which to use, 129

Source indicator, 14, 56, 156
spectra
saving as group, 113
saving automatically, 27, 111
subtracting, 121
where to save, 111
spectral library
adding spectrum to, 110
creating, 7, 49, 108
searching, 106
spectral quality checks, 29, 104
spectral range, 69
detector-beamsplitter, 61
visible, 68
spectral region
selecting, 124
spectral regions
for library search, 108
spectral window, 20
spectrometer
aligning, 132
cover, 157, 159
diagnostics, 130
letting stabilize, 14
maintaining, 132
maintenance, 131
not aligned, 159
not purged, 162, 163
optical layout, 52, 53
out of alignment, 163
parameters, 28
performance test, 139
purging, 10, 11
rear panel, 54
replacing parts in, 130
service, 131
servicing, 135
status, 21
troubleshooting, 155
turning off, 55
turning on, 13, 55
when to align, 128
when to open cover of, 127
when to turn off, 129
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spectrum
background, 22
baseline not flat, 163
cannot be added to library, 153
carbon dioxide peaks in, 162
collecting, 19, 22, 25, 102
collecting with SST, 76
color, 115
comparing with QC library spectra, 42
copying and pasting, 125
correcting, 106
correcting baseline of, 120
correcting with phase array, 80
deleting, 113
derivative-shaped peaks in, 161
distorted, 67
entering title for, 30
fringes or channeling in, 163
labeling, 40
moving in pane, 118
moving stacked, 118
moving to another window, 118
no peaks in, 162
noise in, 164
opening, 111
preparing for search, 106
preparing to collect, 9
previewing before printing, 115
ratioing against common stored background, 77
ratioing with SST, 77
saving, 36
selecting, 115
totally absorbing peaks in, 162
units, 37, 102, 105
water peaks in, 162
zooming in on area of, 117
specular reflection, 91, 161
SST, 75
collecting data using, 76
ratioing spectra using, 77
starting
Bench Diagnostics, 145
OMNIC, 16
remote diagnostics, 143
SST, 75
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step scan, 2, 74, 76
subtracting spectra, 121
subtraction
when to use, 121
system accessories, 92
System Validation, 91

t
task window
closing, 124
telephone for remote diagnostics, 143, 144
telephone numbers, 3
TGA interface, 91
time-resolved step scan, 91
title
entering for sample spectrum, 30
tool
annotation, 39
information, 39
selecting, 39
toolbar, 21
tools, 39
totally absorbing bands
blanking, 106
transmission accessory, 86, 91
troubleshooting
applications, 161
software, 153
spectrometer, 155
TRS, 2
diagnostics, 150
TRS step scan, 80
turning off spectrometer, 55
turning off system, 15, 56
turning on computer, 14, 56
turning on spectrometer, 13, 55
tutorials, 6, 7
Getting Started, 2

u
uninterruptable power supply, 92
units used for spectrum, 37, 102, 105

User Example Library, 47
user library
adding spectrum to, 47
creating, 49
saving spectra in, 112
user name
entering in OMNIC, 16

v
validation wheel, 91
VCD, 90
velocity, 69, 71
vibration
slow scan affected by, 74
View Collect Status button, 34
visible spectral range, 68
diagnostics, 146

w
wall jack for remote diagnostics, 145
water peaks, 162
removing, 107

wavenumber accuracy, 65
window
closing, 124
Window options, 116
Windows metafile, 125
wizard, 6, 7, 49

x
X value
finding, 119

y
Y value
finding, 119
Y-axis, 116

z
Zoom button, 46
zooming in on spectrum, 117
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